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Benvenuto, Benvenuta

Trasformiano insieme l’industria televisiva in un hub creativo. La nostra visione  

è di rendere la migliore tecnologia accessibile a tutti.

In passato le produzioni televisive e la post produzione professionale richiedevano 

un investimento multimilionario in hardware. Ora grazie a Blackmagic Design, anche 

l’hardware video per l’Ultra HD 60p è a portata di tutti. Buon lavoro con UltraStudio, 

DeckLink, e Intensity, e buon divertimento con i migliori software di design e 

produzione TV.

Questo manuale contiene tutte le informazioni per installare l’hardware video di 

Blackmagic Design. Per montare una scheda PCI Express nel computer per la prima volta 

è sempre consigliabile richiedere assistenza tecnica. I dispositivi Blackmagic Design 

utilizzano video non compresso e una frequenza dati elevata, quindi sono necessari 

un’archiviazione veloce e un computer potente.

Solitamente l’installazione richiede circa 10 minuti. Consulta la pagina Supporto del 

nostro sito web su www.blackmagicdesign.com/it per scaricare gli aggiornamenti del 

manuale e del software Desktop Video. Come ultimo passo registra il dispositivo con i 

tuoi dati personali per ricevere le notifiche sulla disponibilità del software Desktop Video 

più recente e sulle nuove funzioni. Non esitare a condividere con noi il tuo showreel 

completato con l’hardware video di Blackmagic Design, e i tuoi commenti riguardo al 

software. Blackmagic è in costante stato di innovazione. I tuoi suggerimenti sono preziosi 

perché ci consentono di migliorare prestazioni e funzionalità.

Grant Petty

AD di Blackmagic Design
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Operazioni preliminari

Introduzione a Desktop Video
Questo manuale indica i requisiti di sistema del computer e le istruzioni per installare hardware 
e software Desktop Video di Blackmagic Design, e come utilizzarli con i software di terzi che 
preferisci.

ll software Blackmagic Desktop Video include driver, plug-in e applicazioni tra cui Blackmagic 
Desktop Video Setup, e Blackmagic Media Express per acquisizione e riproduzione veloci. 
Questo software funziona congiuntamente all’hardware di UltraStudio, DeckLink, Intensity, 
e Teranex. 

 

Requisiti di sistema
Per un’elaborazione video efficiente è necessario un computer con almeno 8GB di RAM. 

Mac OS
Il software Blackmagic Desktop Video è compatibile con le ultime versioni di Mac OS.

Windows
Desktop Video è supportato esclusivamente dalle versioni a 64 bit di Windows 7, 8 e 10 con  
gli ultimi service pack installati. 

Linux
Desktop Video è supportato dai computer x86 a 32 bit e a 64 bit con il sistema operativo  
Linux 2.6.23 o successivo. Consulta le note di rilascio per la lista più recente delle distribuzioni 
Linux supportate, dei formati dei pacchetti, e delle dipendenze del software.

Collegare l'alimentazione
Se l’hardware Desktop Video dispone di un alimentatore esterno, connettilo all’unità e accendi 
il dispositivo.
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Collegare l’hardware video
I dispositivi Blackmagic Desktop Video si possono collegare al computer tramite 3 tipi di 
connettori: Thunderbolt, USB 3.0, e PCIe. 

Connessione tramite Thunderbolt
Blackmagic UltraStudio 4K e UltraStudio 4K Extreme dispongono di due porte Thunderbolt™ 2, 
una per collegarsi a un computer e una per collegare un RAID o un altro dispositivo. 

SUGGERIMENTO DeckLink 4K Extreme 12G si può alimentare anche con il cavo 
adattatore di alimentazione incluso alla scheda. DeckLink 4K Extreme 12G è 
incredibilmente avanzato, e in grado di fornire altre funzionalità tra cui una scheda 
mezzanino per una connettività ancora più estesa. Un cavo adattatore di 
alimentazione è incluso proprio per offrire alimentazione aggiuntiva alla scheda 
DeckLink in caso di un’espansione futura dell’hardware che richiede più potenza 
di quella offerta dallo slot PCIe del computer.

 

Collega DeckLink 4K Extreme 12G all’alimentazione esterna disconnettendo  
il connettore dalla scheda grafica e collegandolo al cavo adattatore.  
La presa si connette solo da un lato quindi non c’è margine d’errore.
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Blackmagic UltraStudio 4K Extreme 3 include due porte Thunderbolt™ 3 e UltraStudio HD Mini 
una porta Thunderbolt™ 3, con un trasferimento dati di 40Gb/s. Per collegare il dispositivo 
Blackmagic Desktop Video al computer basta un unico cavo Thunderbolt 3. Nota che 
l’adattatore da Thunderbolt 3 a Thunderbolt 2 non è supportato sui dispositivi con 
alimentazione tramite bus come UltraStudio HD Mini.

Se il tuo computer è compatibile con Thunderbolt 3, vedrai l’icona Thunderbolt a lato della porta USB C

Connessione tramite USB 3.0
Collega un cavo USB 3.0 SuperSpeed tra la porta USB 3.0 del dispositivo e la porta USB 3.0 
del computer. 

HDMI IN Y IN Pb IN Pr IN S-VIDEO IN VIDEO IN L AUDIO IN

AUDIO OUTVIDEO OUTS-VIDEO OUTPr OUTPb OUTY OUTHDMI OUT

R

Connetti un cavo USB 3.0 SuperSpeed a Intensity Shuttle 

Connessione tramite PCIe
Le schede PCIe di Blackmagic Design si inseriscono nello slot PCIe del computer. 
Per informazioni sul numero di corsie PCIe necessarie, controlla la scatola della scheda. 
Per esempio, in base alla scheda PCIe utilizzata, sarà necessario uno slot a 1, 4 o 8 corsie.

È possibile inserire una scheda PCIe in uno slot più capiente, per esempio una scheda PCIe a 
4 corsie in uno slot a 16 corsie, ma non viceversa.

Se non trovi le informazioni necessarie sulla scatola, puoi consultare le specifiche tecniche 
della scheda sul nostro sito alla pagina www.blackmagicdesign.com/it/products.
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Installa la scheda PCIe di Blackmagic Design in uno slot PCIe disponibile. 
Se include un sostegno rigido per HDMI, inserisci la scheda nello slot PCIe 
e connetti i cavi inclusi sul retro della scheda alle connessioni

Se la scheda include un cavo breakout, collegalo alla porta corrispondente

Quando installi DeckLink PCIe nel computer, fai attenzione  
a non danneggiare i componenti delicati della scheda. 
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Connettere UltraStudio 4K Extreme tramite PCIe
È possibile connettere UltraStudio 4K Extreme e UltraStudio 4K Extreme 3 al computer 
tramite PCIe con una scheda e un cavo adattatore per PCIe. Entrambi i modelli 
UltraStudio si connettono a uno slot PCIe Gen 2 nel computer. Il kit per PCIe 
Blackmagic PCIe Cable Kit contiene un cavo PCIe e una scheda adattatrice PCIe,  
ed è disponibile dai rivenditori autorizzati Blackmagic Design.

Per il modello originale UltraStudio 4K Extreme puoi sfruttare il Blackmagic PCIe  
Cable Kit o acquistare una scheda adattattatrice PCIe standard da qualsiasi negozio  
di elettronica. 

UltraStudio 4K Extreme include una porta PCIe per connettersi  
a una scheda adattatrice PCIe installata sul computer

Inserisci la scheda adattatrice PCIe nello slot PCIe Gen 2 del computer

Connetti l’altra estremità del cavo PCIe  
alla porta PCIe sul retro del computer 
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Installare il software di Desktop Video

Applicazioni, plug-in e driver
Il software include tutti i driver, plug-in, e applicazioni necessari per utilizzare il tuo hardware 
Desktop Video. La tabella seguente mostra esattamente cosa è incluso nel software in base 
alla piattaforma.

Mac OS Windows Linux

Driver di Blackmagic Desktop 
Video

Driver di Blackmagic Desktop 
Video

Driver di Blackmagic Desktop 
Video

Blackmagic Desktop Video Setup Blackmagic Desktop Video Setup Blackmagic Desktop Video Setup

Blackmagic Design LiveKey Blackmagic Design LiveKey –

Blackmagic Media Express Blackmagic Media Express Blackmagic Media Express

Codec Blackmagic QuickTime™
Codec Blackmagic AVI e 
QuickTime™

–

Blackmagic Disk Speed Test Blackmagic Disk Speed Test –

Adobe Premiere Pro CC, 
After Effects CC, predefiniti 
Photoshop CC e plug-in

Adobe Premiere Pro CC, 
After Effects CC, predefiniti 
Photoshop CC e plug-in

–

Plug-in Final Cut Pro X – –

Plug-in Avid Media Composer Plug-in Avid Media Composer –

Aggiornamenti automatici
Una volta installato il software Desktop Video e riavviato il computer, appare una finestra di 
dialogo se la versione installata sul tuo computer non è la più recente. Clicca OK per aggiornare 
il software e riavvia il computer per finalizzare l’update.

NOTA Se la scheda DeckLink non funziona correttamente a causa di un 
aggiornamento interrotto, consulta la sezione “Recuperare una scheda DeckLink dopo 
un aggiornamento non riuscito”.

Il resto di questa sezione mostra come installare il software Desktop Video su Mac OS, 
Windows, e Linux. 

Installazione su Mac OS
Per installare qualsiasi software è necessario avere i privilegi di amministratore.

1 Assicurati di avere l'ultima versione del driver. È disponibile alla pagina Supporto  
www.blackmagicdesign.com/it/support

2 Lancia l’Installer di Desktop Video dalla chiavetta/scheda in dotazione al dispositivo 
Blackmagic Design, o dal file scaricato dalla pagina Supporto.

3 Clicca su Continue, Agree e Install per completare l'installazione del software.
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4 Riavvia il computer per abilitare i nuovi driver.

Installer di Desktop Video per Mac

NOTA Se installi Desktop Video su macOS High Sierra o successivo per la prima volta, 
è necessario abilitare i dispositivi Desktop Video durante il processo di installazione. 

Per abilitare le estensioni su macOS High Sierra o successivo:
1 Quando appare l’avviso di blocco delle estensioni, apri Preferenze di Sistema  

e clicca su Sicurezza e Privacy.

2 Qui clicca su Consenti per abilitare il software Desktop Video sul computer.

Clicca su Consenti per abilitare il software 
Desktop Video sul computer

3 Ritorna all’Installer di Desktop Video e completa l’installazione del software 
cliccando Riavvia.
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Installazione su Windows
1 Assicurati di avere l'ultima versione del driver. È disponibile alla pagina Supporto  

www.blackmagicdesign.com/it/support

2 Apri la cartella Desktop Video e lancia l’installer.

3 I driver si installano sul computer. Quando appare il messaggio Do you want to allow 
the following program to install software on this computer?, che richiede 
l'autorizzazione per installare il software sul computer, clicca su Yes.

4 Una finestra di dialogo mostrerà il messaggio Found new hardware per comunicare  
il rilevamento di un nuovo hardware. Seleziona Install automatically per consentire  
al sistema di trovare i driver Desktop Video necessari.

SUGGERIMENTO Quando un DeckLink Quad 2 è installato su un computer 
Windows 7, Windows Update tenterà di aggiornare ogni driver. In questo 
caso particolare non è necessario perché l’ultima versione di Desktop Video 
li aggiorna automaticamente. Per disabilitare Windows Update 
temporaneamente, clicca sulla notifica e seleziona Skip obtaining driver 
software from Windows Update, poi Yes. Ora l’installazione avanza 
più velocemente.

5 A fine installazione, tutti i driver saranno aggiornati, e apparirà un messaggio di 
conferma Your new hardware is ready for use. Riavvia il computer per abilitare  
i nuovi driver.

Installer di Desktop Video per Windows

Installazione su Linux
1 Scarica l’ultima versione Desktop Video per Linux alla pagina Supporto  

www.blackmagicdesign.com/it/support.

2 Apri la cartella Desktop Video e scegli il pacchetto in base alla distribuzione e 
architettura utilizzate. La voce amd64 si riferisce ai processori Intel e AMD a 64 bit. 
Sono presenti 3 pacchetti:

 � desktopvideo include i driver principali e le librerie API.

 � desktopvideo-gui fornisce il software Desktop Video Setup. 
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 � mediaexpress racchiude una semplice utilità di acquisizione e riproduzione.

3 Clicca due volte sui pacchetti per installarli e segui le istruzioni su schermo.  
Se appaiono messaggi su dipendenze mancanti, verifica di averle installate  
e poi lancia di nuovo l’Installer.

4 Una volta terminata l’installazione, riavvia il computer.

Se non trovi un pacchetto nativo Desktop Video per la distribuzione Linux, o se preferisci 
installare direttamente da una riga di comando, consulta il Readme per le informazioni 
dettagliate sull’installazione.

Il software Desktop Video pronto all’installazione sull’Ubuntu Software Center

Aggiornamenti
Se non hai installato il software, puoi controllare che il software interno sia aggiornato 
utilizzando il comando di BlackmagicFirmwareUpdater:

# BlackmagicFirmwareUpdater status

Apparirà il messaggio seguente (o simile):

0: /dev/blackmagic/io0 [DeckLink SDI 4K] 0x73 OK

1: /dev/blackmagic/io1 [DeckLink 4K Extreme 12G] 0x0A PLEASE _ UPDATE

In questo caso puoi aggiornare il software interno con il seguente comando:

# BlackmagicFirmwareUpdater update 1

Consulta la pagina man per maggiori informazioni sull’uso dei comandi. Per esempio,  
digita man BlackmagicFirmwareUpdater per i dettagli sul comando di aggiornamento del 
software interno.

Ecco completate le operazioni preliminari. Ora che hai installato l’hardware e il software 
Blackmagic Desktop Video, puoi cominciare ad acquisire e a riprodurre il video.
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Acquisizione e riproduzione video 
Una volta installato l’hardware e il software Desktop Video, puoi cominciare immediatamente 
ad acquisire e a riprodurre le clip. Prima di tutto, collega la sorgente video all’ingresso del 
dispositivo Desktop Video, e il monitor all’uscita.

Un metodo veloce e diretto per acquisire e riprodurre video è registrare una clip con 
Blackmagic Media Express, precedentemente installato sul computer con il software 
Desktop Video.

Configurazione
1 Collega un monitor o uno schermo Tv all’uscita video del dispositivo 

Blackmagic Design.

2 Collega una sorgente video all’ingresso del dispositivo Blackmagic Design.

A B NTSC
PAL
Y

SDI OUT

HDMI OUT

REMOTE

SDI IN

ANALOG VIDEO IN

REF IN
CH 1 CH 2
ANALOG AUDIO IN

B-Y R-Y

SDI OUT

+ 12V 

SDI IN

REF IN
TC IN

Ultra Studio HD Mini

URSA Mini Pro

HDTV

Collega un monitor e una sorgente video al dispositivo Blackmagic Design

Testare l’acquisizione video
1 Lancia Blackmagic Media Express. Clicca sulla tab Log and capture. Il formato video in 

entrata è rilevato automaticamente, e Media Express imposta il formato del progetto 
corrispondente. La sorgente video appare nel pannello di anteprima di Media Express.

2 Clicca Capture in basso alla finestra Log and capture per testare le prestazioni di 
acquisizione. Clicca di nuovo Capture per terminare il test. La clip si aggiunge alla lista 
dei file sulla sinistra di Media Express.
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Clicca su Capture per cominciare l’acquisizione video

Testare la riproduzione video
1 Clicca sulla tab Playback.

2 Fai doppio clic sulla clip di test. Il video (e l’audio, se presente) sarà inviato al monitor 
connesso all’uscita del tuo dispositivo.

Blackmagic Desktop Video Setup

Introduzione a Blackmagic Desktop Video Setup
L’utilità Blackmagic Desktop Video Setup è la postazione centrale da cui configurare l’hardware. 
Inoltre mostra in tempo reale il video connesso agli ingressi e alle uscite dell’hardware.

Per lanciare Blackmagic Desktop Video Setup:
 � Su Mac OS, seleziona Blackmagic Desktop Video da Preferenze di Sistema, oppure 

dalla cartella Applicazioni. 

 � Su Windows 7, clicca sul pulsante Start > Tutti i programmi > Blackmagic Design > 
Desktop Video e clicca sull’applicazione Blackmagic Desktop Video Setup. Oppure 
apri l’utilità dal Pannello di Controllo di Windows 7.

 � Su Windows 8, dalla pagina Start digita Blackmagic e poi clicca sull’applicazione 
Blackmagic Desktop Video Setup. Oppure apri l’utilità dal Pannello di Controllo di 
Windows 8.

 � Su Windows 10, seleziona Start > Tutti i programmi > Blackmagic Design > Desktop 
Video e clicca sull’applicazione Blackmagic Desktop Video Setup. Oppure apri l’utilità 
dal Pannello di Controllo di Windows 10. 

 � Su Linux, seleziona Applicazioni > Audio e video > Blackmagic Desktop Video Setup. 

Una volta aperto Blackmagic Desktop Video Setup, la pagina iniziale mostra una panoramica 
dei dispositivi connessi e delle attività video di ingressi e uscite. Quando il dispositivo riceve 
segnali, l’utilità rileva il formato automaticamente e lo fa apparire sotto l’icona 
dell’ingresso video.
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Se sono connessi più dispositivi di acquisizione e riproduzione, puoi passare da uno all’altro 
cliccando sulle frecce a lato della pagina iniziale. Per accedere alle impostazioni, clicca 
sull’icona del dispositivo, o sull’icona sotto il nome dell’hardware. L’utilità Desktop Video Setup 
mostra solamente le impostazioni per il dispositivo selezionato, evitando di perdere tempo con 
menù complicati. 

La pagina iniziale di Blackmagic Desktop Video Setup

Le pagine seguenti del manuale mostrano come regolare le impostazioni con Blackmagic 
Desktop Video Setup.

Con Blackmagic Desktop Video Setup puoi regolare le impostazioni di ingressi 
e uscite, eseguire conversioni di maggiore o di minore risoluzione in fase 
di acquisizione e riproduzione, e ottenere informazioni sul driver
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Impostazioni Video

Ingresso video
Seleziona l’ingresso video del dispositivo Blackmagic Design cliccando sull’icona del 
connettore corrispondente. Vedrai solo le connessioni integrate nell’hardware. Quando il 
dispositivo riceve segnali, l’utilità rileva il formato automaticamente e lo fa apparire sotto l’icona 
dell’ingresso video sulla pagina iniziale. 

Seleziona l’ingresso video cliccando sul connettore corrispondente

Utilizzare il timecode XLR
Spunta la casella Use XLR Timecode Input per rilevare il timecode dall’ingresso XLR invece 
che dal flusso SDI.

Spunta questa casella per acquisire il timecode dall’ingresso XLR

Livelli del video analogico in entrata
Trascina gli slider per regolare i livelli del video analogico in entrata per il video a componenti  
o per il video composito. Spostando lo slider per il video Y, il gain di luminanza Cb e di 
crominanza Cr aumenta o diminuisce la saturazione del colore. Quando si utilizza il video a 
componenti, puoi regolare i valori di Cb e Cr separatamente. Clicca sull’icona di collegamento 
sulla destra per regolarli simultaneamente.

Uscita video
Seleziona lo standard video e regola le impostazioni dell’uscita video.

Impostazioni generali
 � Standard video di default

Alla voce Default Video Standard seleziona lo stesso formato video del tuo progetto 
se utilizzi Final Cut Pro X con un monitor broadcast.

 � Video in pausa
Seleziona la prima opzione di When Paused per visualizzare l’immagine intera,  
o la seconda per mostrare un solo fotogramma quando il video è in pausa.
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 � Riproduzione video
Seleziona la prima opzione di Video Playback per visualizzare un’immagine nera,  
o la seconda per mostrare un fermo immagine quando il video non è riprodotto.

 � Acquisizione video
Seleziona la prima opzione di During Capture per mostrare il video riprodotto,  
o la seconda per visualizzare il video in entrata durante l’acquisizione. Selezionando  
la prima opzione, verrà visualizzato quanto impostato alla voce Video Playback. 
Selezionando la seconda opzione, l’uscita visualizza il video in entrata.

 � Durante la riproduzione video
Alcuni prodotti Desktop Video possono convertire il video in uscita Rec.601 e Rec.709 
in Rec.2020 per renderlo compatibile con determinati televisori e monitor. Se il tuo 
dispositivo Desktop Video supporta questa funzione, seleziona During Playback > 
Convert to Rec.2020 nel menù impostazioni del software. Seleziona la prima opzione 
Keep default color gamut per mantenere lo spazio colore attuale se il video viene 
visualizzato correttamente, o se utilizza già lo spazio colore Rec.2020. 

Seleziona cosa visualizzare sullo schermo quando il video  
è in pausa, in riproduzione, o in fase di acquisizione

Uscita SDI
 � Spazio colore

La voce Color Space serve per selezionare lo spazio colore nel quale convertire 
l’uscita video. Le due opzioni sono RGB 4:4:4:4 o Y, Cb, Cr 4:2:2.

 � Formati 3G-SDI
La voce 3G-SDI Formats consente di scegliere se inviare i segnali con mappatura 
SMPTE come livello A o livello B.

 � HD a 1080p e 2K
Seleziona la prima opzione per inviare i segnali HD 1080p e 2K come video 
progressivo, oppure la seconda opzione per inviare immagini segmentate progressive.

Controlla i segnali video SDI in uscita dalla sezione SDI Output
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 � Configurazione SDI
Seleziona il connettore Single Link, Dual Link, e Quad Link per inviare segnali 3G, 6G, 
o 12G-SDI. Alcuni monitor e proiettori professionali per la correzione colore sono 
compatibili solo con segnali ad ampia larghezza di banda come 2160p60 o 4K 4:4:4 
tramite quad link. UltraStudio 4K Extreme invia segnali 3G-SDI quad link, oppure puoi 
acquistare una scheda aggiuntiva con quad SDI per DeckLink 4K Extreme 12G. 

Scegli tra single link, dual link, e quad link per inviare segnali video 3G, 6G e 12G SDI

 � Formati 8K
Il video 8K viene distribuito con una connessione quad link. 

Le due opzioni di 8K formats disponibili sono:

Are output as Square Division Quad Split (SQ) L’immagine 8K viene inviata come  
4 x riquadri 4K separati in una disposizione multiview di 2 x 2. Ogni riquadro 4K è 
distribuito tramite SDI con una connessione quad link, e l’immagine 8K completa 
ricostruita a destinazione. Usa questa opzione per inviare 4 x segnali separati ad 
altrettanti monitor Ultra HD e creare un video wall. 

Are output as Sample Interleave (SI) I pixel alternati di una singola immagine 8K sono 
distribuiti come 4 x immagini 4K separate tramite SDI con una connessione quad link,  
e l’immagine 8K completa ricostruita a destinazione. Di conseguenza, il vantaggio di 
questo formato è poter utilizzare ognuna della 4 uscite come immagine 4K convertita.

Quando utilizzi un dispositivo Desktop Video per la riproduzione di  
video 8K, scegli il formato 8K di distribuzione del quad link in uscita

Impostare l’uscita di video analogico
Se usi un dispositivo Blackmagic Design con connettori per video analogico condivisi, puoi 
scegliere se inviare il video tramite connessioni a componenti, composito, o S-Video, 
selezionando tra le opzioni di Analog Video Output.

Uscita HDMI per 3D 
Questa impostazione determina il formato 3D per il monitoraggio tramite HDMI.

 � Top and Bottom
Combina le immagini dell’occhio destro e dell’occhio sinistro verticalmente con una 
compressione del 50%.

 � Frame Packing
Combina le immagini dell’occhio destro e dell’occhio sinistro in un unico fotogramma 
senza compressione.

 � Side by Side
Combina le immagini dell’occhio destro e dell’occhio sinistro orizzontalmente con una 
compressione del 50%.

 � Left Eye 
Visualizza solo l’immagine dell’occhio sinistro.

 � Line by Line 
Le immagini dell’occhio destro e sinistro si interlacciano linea per linea senza 
compressione.
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 � Right Eye 
Visualizza solo l’immagine dell’occhio destro.

Imposta il formato 3D sull’uscita HDMI

Livelli del video analogico in uscita
Trascina gli slider per regolare i livelli del video analogico in uscita per il video a componenti o 
per il video composito. Spostando lo slider per il video Y, il gain di luminanza Cb e di 
crominanza Cr aumenta o diminuisce la saturazione del colore. Quando si utilizza il video a 
componenti, puoi regolare i valori di Cb e Cr separatamente. Clicca sull’icona di collegamento 
sulla destra per regolarli simultaneamente. 

Regola lo slider Y per impostare i livelli di video analogico in uscita, e gli  
slider Cb e Cr per il bilanciamento del colore del video a componenti

 � Use Betacam Levels 
I dispositivi Blackmagic Design utilizzano i livelli SMPTE per il video analogico a 
componenti per mantenere la compatibilità con l’attrezzatura video più moderna. 
Spunta questa casella se utilizzi i deck Sony Betacam SP.

 � NTSC IRE 
Seleziona il livello IRE 7.5 USA per il video composito NTSC utilizzato negli Stati Uniti e  
in altri Paesi. Seleziona il livello IRE 0.0 Japan per i progetti in Giappone o per i Paesi che 
non usano il setting 7.5 IRE. Queste impostazioni non riguardano i formati PAL e HD. 

Spunta la casella Use Betacam Levels se utilizzi i deck Sony Betacam SP.  
Seleziona il livello IRE appropriato quando usi un formato di video composito NTSC

Ingresso di riferimento
Il parametro Reference Input consente di sincronizzare le uscite video dell’hardware in 
funzione dell’ingresso di riferimento. È un’impostazione normalmente utilizzata nei grandi studi 
di trasmissione broadcast, in cui i segnali in uscita devono essere perfettamente sincronizzati. 
Ecco perché la regolazione del riferimento è a livello dei singoli campioni. 

Per esempio, regolando opportunamente questo parametro all’interno di un’installazione dove 
tutti i dispositivi sono connessi allo stesso riferimento stabile, ogni uscita video sarà 
perfettamente sincronizzata. In questo modo è possibile commutare tra un dispositivo e l’altro 
con un router o uno switcher di produzione eliminando ritardi ed errori. 
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Regola la sincronizzazione del video in uscita secondo l’ingresso di riferimento

Mappatura dei connettori per DeckLink Quad 2
Se una scheda DeckLink Quad 2 è installata nel tuo computer, è possibile inviare o ricevere  
i segnali SDI attraverso 8 connettori BNC mini indipendenti. In questo modo puoi gestire 8 flussi 
video, e sarà come avere 8 dispositivi di acquisizione e riproduzione separati in una sola 
scheda. Ecco perché DeckLink Quad 2 appare sul software Desktop Video Setup come 
8 dispositivi DeckLink separati. Rende ancora più immediata la configurazione degli ingressi e 
delle uscite. Puoi anche dare un nome a ogni dispositivo, e monitorare determinati segnali.

Anche i connettori SDI si possono assegnare a un determinato dispositivo dalle impostazioni 
Connettor Mapping dell’utilità Desktop Video Setup, ma fai attenzione: sono già destinati a 
dispositivi specifici. Per esempio SDI 1 è assegnabile a DeckLink Quad (1), mentre SDI 2 è 
assegnabile a DeckLink Quad (1) e DeckLink Quad (5).

Con un DeckLink Quad 2 installato, l’impostazione Connector Mapping consente 
di assegnare i connettori SDI a diversi dispositivi DeckLink Quad

La tabella di riferimento qui sotto mostra quali connettori SDI assegnare a diversi dispositivi 
DeckLink Quad.

Opzioni di configurazione

Dispositivi DeckLink Quad Connettori SDI dedicati

DeckLink Quad (1) SDI 1 e 2, o SDI 1

DeckLink Quad (2) SDI 3 e 4, o SDI 3

DeckLink Quad (3) SDI 5 e 6, o SDI 5

DeckLink Quad (4) SDI 7 e 8, o SDI 7

DeckLink Quad (5) SDI 2 o nessuno

DeckLink Quad (6) SDI 4 o nessuno

DeckLink Quad (7) SDI 6 o nessuno

DeckLink Quad (8) SDI 8 o nessuno

È importante ricordare che se assegni un connettore SDI a un dispositivo specifico, questo 
incide sul dispositivo che condivide il connettore. Per esempio, se DeckLink Quad (1) è 
assegnato al connettore SDI 1 e 2, DeckLink Quad 5 si imposta automaticamente su nessuno, 
perché il connettore SDI condiviso è in uso. Oppure, se assegni SDI 2 a DeckLink Quad (5), 
DeckLink Quad (1) passa automaticamente al connettore SDI 1. Per questo motivo, è importante 
farsi un appunto di quali ingressi o uscite sono in uso per ogni dispositivo, evitando di 
interrompere la connessione di un altro dispositivo.
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SUGGERIMENTO Se hai già installato il modello originale di DeckLink Quad nel tuo 
sistema e stai utilizzando un’applicazione sviluppata su misura con un pacchetto SDK, 
DeckLink Quad 2 sarà perfettamente compatibile con il sistema, senza bisogno di 
cambiamenti. Le funzioni di configurazione addizionali di DeckLink Quad 2 ti 
consentono di migliorare il sistema aggiungendo più opzioni di ingressi e uscite 
secondo necessità.

Impostazioni audio

Ingresso audio
Nella tab Audio selezioni l’ingresso audio del dispositivo Blackmagic Design cliccando 
sull’icona del connettore corrispondente. Le opzioni sono:

 � Embedded
I canali audio sono integrati ai segnali video. I flussi SDI e HDMI supportano l’audio 
integrato.

 � AES/EBU
Un singolo connettore trasporta 2 canali audio in un segnale audio digitale.

 � XLR
Connettore audio a tre pin per l’utilizzo con attrezzatura professionale per audio 
analogico. 

 � RCA / HIFI
Connettore per collegare l’audio analogico sbilanciato d/ai dispositivi audio di largo 
consumo, per esempio sistemi hi-fi, lettori DVD e televisori.

 � Microphone
L’alimentazione phantom passa attraverso i cavi del microfono ed è una pratica fonte  
di alimentazione per i microfoni a condensatore. 

Spunta la casella Use +48V Phantom Power se il microfono richiede alimentazione 
phantom. Se non si è certi del tipo di microfono, è consigliabile non spuntare la casella, 
perché l’alimentazione phantom potrebbe causare danni ai microfoni con alimentazione 
propria. Quando l’alimentazione phantom è attiva, una spia LED si illumina sul pannello 
frontale di UltraStudio 4K Extreme. Consigliamo di attendere almeno 10 secondi dalla 
disconnessione dell’alimentazione phanton prima di connettere un microfono con 
alimentazione propria. I vecchi modelli di microfono a nastro e i microfoni dinamici non 
sono compatibili con l’alimentazione phantom.

Seleziona l’ingresso audio cliccando sull’icona del connettore corrispondente

Trascina lo slider Input Level per regolare il livello del microfono in entrata
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Uscita audio HDMI
Con questo parametro puoi rimappare i canali audio 5.1 di un progetto per farli corrispondere 
alla configurazione dell’attrezzatura di monitoraggio HDMI. Per esempio, alcuni ricevitori A/V 
per home theatre richiedono che l’audio surround sia mappato su canali specifici. Se stai 
lavorando a un progetto che utilizza un ordine di canali differente per l’audio surround (per 
esempio SMPTE), puoi selezionare la casella Use 5.1 surround channel ordering per rendere 
compatibile il ricevitore A/V HDMI.

Spunta la casella Use 5.1 surround channel ordering per abilitare la 
compatibilità con l’attrezzatura di monitoraggio HDMI

AES/EBU
Trascina gli slider per regolare il livello di riferimento, o guadagno, per gli ingressi e le uscite 
AES/EBU. Clicca sulla freccia circolare per resettare il guadagno su 0 dB.

Trascina lo slider Output Level per regolare il livello dell’audio digitale AES/EBU in uscita

Livelli audio analogico in entrata

Channel 1, Channel 2
Regola il guadagno dell’audio analogico in entrata durante l’acquisizione. Clicca 
sull’icona di collegamento sulla destra per regolare i due canali simultaneamente.

Use HiFi Audio Levels
Le connessioni professionali XLR sono di serie sui modelli UltraStudio e DeckLink.  
Se vuoi collegare attrezzatura audio di largo consumo alle porte XLR, è necessario 
spuntare questa casella, e utilizzare un adattatore da RCA a XLR.

Muovi lo slider per controllare i livelli dell’audio analogico in entrata. Spunta la casella Use 
HiFi Audio Levels se colleghi attrezzatura audio di largo consumo alle porte XLR

Livelli audio analogico in uscita

Channel 1, Channel 2
Regola la potenza del segnale audio, o guadagno, delle uscite di audio analogico  
in fase di riproduzione del video. Clicca sull’icona di collegamento sulla destra per 
regolare i due canali simultaneamente.
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Icona di reset
A volte è utile resettare i cambiamenti in fase di regolazione. L’icona di reset è una freccia circolare 
sulla destra di ogni sezione di regolazione. Clicca sull’icona per resettare il guadagno su 0 dB.

Impostazioni delle conversioni

Conversione in entrata
Questa impostazione nella tab Conversions > Input Conversion abilita la conversione in 
maggiore o in minore risoluzione in tempo reale durante l’acquisizione. Seleziona il tipo di 
conversione dal menù a discesa.

La conversione dei segnali in entrata risulta in un ritardo di circa 2 fotogrammi, quindi è 
necessario regolare il timecode offset del software di montaggio per assicurare sincronizzazione.

Display As 
Seleziona come visualizzare il video convertito. Secondo il rapporto d'aspetto del video 
originale, le opzioni includono letterbox, anamorfico, center cut, pillarbox, 16:9 (zoom),  
o 14:9 (zoom).

Conversione in uscita
Questa impostazione nella tab Conversions > Output Conversion abilita la conversione in 
maggiore o in minore risoluzione in tempo reale durante la riproduzione. Seleziona il tipo di 
conversione dal menù a discesa.

La conversione dei segnali in uscita risulta in un ritardo di circa 2 fotogrammi, quindi è necessario 
regolare il timecode offset del software di montaggio per assicurare sincronizzazione.

Convert Analog Outputs
Spunta questa casella per applicare la conversione alle uscite di video analogico.

Display As
Seleziona come visualizzare il video convertito. Secondo il rapporto d'aspetto del video 
originale, le opzioni includono letterbox, anamorfico, center cut, pillarbox, 16:9 (zoom),  
o 14:9 (zoom). 

Per regolare i parametri di conversione in maggiore o in minore 
risoluzione dai rispettivi menù a discesa, clicca sul rapporto d'aspetto 
corrispondente. Ricorda di cliccare su Save per salvare le impostazioni
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La tabella seguente mostra i rapporti d'aspetto selezionabili in fase di conversione.

Conversione 
in minore 
risoluzione

Immagine 
originale

Immagine 
convertita

Letterbox
Ridimensiona l'intera immagine 16:9 HD 
nel formato 4:3 SD, con una barra nera 
sopra e sotto l'immagine.

Anamorphic
Schiaccia l'immagine 16:9 HD 
orizzontale nel formato 4:3 SD.

Center Cut

Taglia un'immagine 4:3 SD dal formato 
16:9 HD, scartando una porzione della 
visuale da entrambi i lati dell'immagine 
16:9.

Pillarbox
Mostra un’immagine 4:3 SD all’interno 
di un’immagine 16:9 HD, con una barra 
nera in entrambi i lati dell'immagine.

16:9 (zoom) 
Ingrandisce l’immagine 4:3 SD per 
riempire lo schermo 16:9 HD. 

14:9 (zoom)
Combina i formati pillarbox 4:3 e 16:9 
(zoom), con sottili barre nere ai lati e un 
leggero crop in alto e in basso.

About

Driver
La tab About dell’utilità Blackmagic Desktop Video Setup mostra le informazioni sul driver del 
dispositivo in Driver Information e sull’ultimo aggiornamento in Product Notes.

SUGGERIMENTO Puoi creare un rapporto di stato cliccando su Status Report > Create. 
Il file generato contiene informazioni tecniche tra cui il formato video di riferimento 
rilevato in entrata e in uscita, lo spazio colore, il campionamento del colore, la profondità 
di bit, e le informazioni sul driver, sul sistema operativo, e sul dispositivo. Il rapporto di 
stato è utile in caso sia necessario contattare il team di Blackmagic Design per 
assistenza tecnica. Il file è di piccole dimensioni e facilmente condivisibile tramite email.

Informazioni sul prodotto
Dare un nome specifico a ogni dispositivo Blackmagic Design aiuta a identificare ogni unità nel 
software Desktop Video Setup, e a monitorare dove e come vengono utilizzate. 
È particolarmente utile quando sono installati vari dispositivi nella stessa rete, oppure per 
differenziare le unità secondo l’uso, per esempio “Suite montaggio 1”, o “Suite colore 2”, ecc.

656Blackmagic Desktop Video Setup



Una volta salvato il nome dell’hardware in Product Notes alla voce Label, questo apparirà sulla 
Home di Blackmagic Desktop Video Setup, sotto l’immagine del prodotto.

Nella stessa sezione puoi salvare altre informazioni utili come il numero seriale, il numero di 
telefono e l’email del venditore, il luogo e la data di acquisto del prodotto.

La sezione About include informazioni utili come la versione del driver, 
il manuale di istruzioni, e le note di rilascio. Qui puoi anche generare 
un rapporto di stato e inserire informazioni specifiche sul prodotto

UltraStudio 4K Mini - Pannello frontale
La maggior parte delle impostazioni di UltraStudio 4K Mini è regolabile dall’utilità Desktop 
Video Setup o dai menù sul display LCD del pannello frontale. Premi il pulsante MENU e ruota 
la manopola per navigare le opzioni. Premi il pulsante SET per confermare la selezione.

Premi MENU per uscire dai menù e tornare alla pagina iniziale.

SUGGERIMENTO Per accedere direttamente alle impostazioni video o audio, premi 
gli omonimi pulsanti frontali invece di navigare i menù.

Audio Meters

VU (-18dBFS)

VU (-20dBFS)

PPM (-18dBFS)

PPM (-20dBFS)

Usa i menù LCD per cambiare le impostazioni di UltraStudio 4K Mini 
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Impostazioni audio
I menù LCD di UltraStudio 4K Mini offrono impostazioni audio aggiuntive. Queste impostazioni 
permettono di cambiare il tipo di indicatori di livello audio visualizzati dal display in fase di 
acquisizione e riproduzione. Gli indicatori disponibili sono VU e PPM.

VU
L’indicatore VU, volume units, misura la media tra i picchi brevi e le valli del segnale 
audio. Se utilizzi questo indicatore, regola i livelli di uscita della sorgente di modo che  
i picchi non superino i 0dB. Così facendo ottimizzi il rapporto segnale/rumore e ottieni 
la migliore qualità audio. Se i picchi superano i 0dB, è altamente probabile che si 
verifichi la distorsione. Se utilizzi gli ingressi analogici di UltraStudio 4K Mini, puoi 
regolarne i livelli dal menù LCD o dall’utilità.

PPM
L’indicatore PPM, peak programma meters, ritiene momentaneamente i picchi del 
segnale con un tempo di caduta lento, segnalando chiaramente il livello a cui l’audio 
raggiunge il suo picco.

Gli indicatori VU e PPM si possono usare con un livello di riferimento di -18dB o -20dB, 
a seconda degli standard di trasmissione internazionali.

Slot per scheda SD
Il pannello frontale di UltraStudio 4K Mini ospita uno slot per scheda SD che legge e scrive i file 
quando l’unità è connessa a un computer Mac o Windows. Lo slot è utilizzabile come un 
normale lettore e scrittore SD, e viene rilevato dal computer come un drive. Questo ti permette 
di importare velocemente le clip dalla scheda SD della camera, o di acquisire una clip su un 
supporto di archiviazione portatile utilizzando Media Express.

Teranex Mini Smart Panel 

Installare un Teranex Mini Smart Panel
Blackmagic UltraStudio HD Mini è una soluzione compatta di acquisizione e riproduzione delle 
stesse dimensioni dei convertitori Teranex Mini e dei deck di registrazione HyperDeck Studio 
Mini. Questi prodotti sono stati progettati per essere portatili e modulari, in studio e in esterna, 
oppure montati sulla scrivania o sulla mensola Teranex Mini Rack Shelf. Questa mensola 
consente di montare l’attrezzatura su un rack.

Montando il pannello opzionale Teranex Mini Smart Panel su UltraStudio HD Mini puoi 
monitorare audio e video direttamente dal pannello frontale dell’unità durante l’acquisizione  
e la riproduzione, sul display LCD integrato.
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Il pannello si installa con facilità senza spegnere Blackmagic UltraStudio HD Mini perché è 
sostituibile a caldo.

1 Estrai le due viti M3 da entrambi i lati di Blackmagic UltraStudio HD Mini con un 
cacciavite Pozidriv 2, e rimuovi delicatamente il pannello in dotazione.

2 Dietro questo pannello, nell'angolo in basso, c'è un tubicino di plastica trasparente.  
Il tubicino illumina la spia LED di stato sul pannello, e non va rimosso.

SUGGERIMENTO Quando riattacchi il pannello frontale in dotazione, 
accertati che il tubicino sia allineato con lo slot frontale.

3 Allinea il connettore situato sul retro del Teranex Mini Smart Panel con il connettore 
attiguo sul lato frontale di UltraStudio HD Mini, e premi delicatamente per bloccarlo in 
posizione. Lo Smart Panel si ancora fermamente al lato frontale di UltraStudio HD Mini.

4 Inserisci le viti M3 precedentemente estratte.

1

2

SET

VIDEO

MENU

AUDIO

Accompagna Teranex Mini Smart Panel con l'indice e il pollice allineati in corrispondenza del 
connettore sul retro per ancorare correttamente il pannello a Blackmagic UltraStudio HD Mini

Se UltraStudio HD Mini è installato sulla mensola Teranex Mini Rack Shelf, è necessario 
rimuoverlo dal rack per accedere alle viti. 

Consulta la sezione "Teranex Mini Rack Shelf" per maggiori informazioni.

Installa il resistente pannello originale in dotazione se desideri collocare Blackmagic UltraStudio 
HD Mini sul retro di un sistema a rack o in una postazione piena di cavi.
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Le caratteristiche di Teranex Mini Smart Panel

Display LCD
La home del display mostra le seguenti informazioni:

Buffer –Il numero di fotogrammi 
bufferizzabili dal sistema durante 
l’acquisizione, o il numero di 
fotogrammi bufferizzati sul 
dispositivo in fase di riproduzione

Source – Il tipo di 
video in entrata (SDI, 
YCbCr, o NTSC/PAL)

1 MENU

2 VIDEO

SET AUDIO

Source

YCbCr
Video Format

525i59.94 NTSC
Buffer

55 fr

Display – Mostra il video in 
arrivo a UltraStudio HD Mini

Livelli audio – Mostra i livelli 
audio del video in arrivo 
su UltraStudio HD Mini

1 MENU

2 VIDEO

SET AUDIO

Source

YCbCr
Video Format

525i59.94 NTSC
Buffer

55 fr

Formato video –Mostra il formato 
del video acquisito o riprodotto

Teranex Mini Rack Shelf
Quando utilizzi Blackmagic UltraStudio HD Mini con dispositivi Blackmagic come ATEM 
Television Studio HD o i convertitori Teranex Mini, la mensola Teranex Mini Rack Shelf è ideale 
per montare le unità su un rack broadcast o in un flightcase. Teranex Mini Rack Shelf misura una 
unità di rack e ospita fino a tre Teranex Mini. 

Per installare UltraStudio HD Mini sulla mensola rimuovi i piedini in gomma (se presenti) e fissa 
l'unità alla base utilizzando i fori di montaggio.

UltraStudio HD Mini

Teranex Mini Rack Shelf include due pannelli ciechi per mascherare gli spazi non utilizzati.

Per maggiori informazioni, visita la pagina www.blackmagicdesign.com/it.
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DaVinci Resolve

Correzione colore live con DaVinci Resolve
Desktop Video 10 consente acquisizione e riproduzione simultanee sui dispositivi 4K e 8K 
di Blackmagic Design. È ideale se si utilizza la funzione di correzione colore live su DaVinci Resolve, 
perché elimina il bisogno di due dispositivi separati per gestire i segnali in entrata e quelli in uscita.

Per fare il color grading in tempo reale sul set, semplicemente collega l’uscita della camera 
all’ingresso del dispositivo Blackmagic Design utilizzato. Poi connetti l’uscita del dispositivo al 
monitor del set per la revisione della correzione colore.

Configurazione
1 Apri DaVinci Resolve. Dal menù Preferences clicca su Video and Audio I/O e seleziona 

il dispositivo utilizzato dalla voce for Resolve Live use. Salva e riavvia DaVinci Resolve 
per implementare le impostazioni.

2 Crea un nuovo progetto e apri la finestra delle impostazioni Project Settings. Dalla tab 
Master Settings seleziona lo stesso frame rate e risoluzione della camera per la timeline.

3 Clicca su Capture and Playback e seleziona il formato di acquisizione e di riproduzione 
desiderato dalla prima voce Video capture and playback.

Seleziona il formato dal menù Video capture and playback

4 Vai alla pagina Edit e seleziona File > New Timeline.

5 Dalla pagina Color clicca sul menù Color > Resolve Live > On. Ora dovrebbero 
apparire le immagini live dalla camera sul visualizzatore, con la dicitura “Resolve Live” in 
rosso sopra il video.
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Utilizzare Resolve Live
1 In modalità Resolve Live, l’icona del fiocco di neve sotto il visualizzatore “congela”,  

o blocca momentaneamente, il fotogramma video corrente. È utile per correggere  
il colore senza la distrazione delle immagini che scorrono durante le riprese. 

2 Una volta finalizzata la correzione, se clicchi sull’icona della macchina fotografica sotto 
il visualizzatore salvi il fotogramma con timecode e correzione sulla timeline. Ora clicca 
sull’icona del fiocco di neve per continuare la riproduzione, fino a trovare la prossima 
scena da correggere.

SUGGERIMENTO Consulta il manuale di DaVinci Resolve per maggiori informazioni 
su Resolve Live.

Montaggio con DaVinci Resolve
Blackmagic DaVinci Resolve offre un’interfaccia user-friendly con tutti gli strumenti di 
montaggio e finitura. È ideale sia con il mouse per trascinare le clip, sia con la tastiera per un 
editing di precisione. DaVinci Resolve include tutte le funzionalità richieste dai professionisti!

Configurazione
1 Apri DaVinci Resolve. Dal menù Preferences clicca su Video and Audio I/O e seleziona 

il dispositivo Blackmagic Design dalla voce for Capture and Playback use. Salva, poi 
riavvia DaVinci Resolve per salvare le impostazioni.

2 Apri un progetto, seleziona Project Settings > Master Settings, scegli la risoluzione 
della timeline Timeline resolution, e il frame rate della timeline Timeline frame rate  
e di riproduzione Playback frame rate.

3 Nella sezione successiva Video Monitoring, seleziona il formato del video in uscita 
Video format dal dispositivo Blackmagic Design.

4 Clicca su Save per salvare i cambiamenti e chiudere la finestra delle impostazioni 
di progetto.

Accedi alle opzioni di formato della timeline e del video  
per il monitoraggio dalla finestra Project Settings
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Montaggio
1 Sulla pagina Media, utilizza il browser Media Storage per importare le clip sull’archivio 

multimediale.

2 Sulla pagina Edit, seleziona File > New timeline, assegna il nome alla timeline e clicca 
su Create.

3 Ora puoi trascinare una clip dall’archivio multimediale sul visualizzatore delle fonti 
sulla sinistra.

4 Seleziona i punti di attacco e di stacco delle clip sorgente utilizzando i tasti I e O e 
trascinando l’indicatore di riproduzione sulla barra sotto la finestra del visualizzatore.

5 Per fare l’editing della clip sulle timeline, trascina la clip dal visualizzatore delle fonti 
sulla timeline.

SUGGERIMENTO Consulta il manuale Blackmagic DaVinci Resolve per maggiori 
informazioni su come montare il video con DaVinci Resolve.

Utilizzare un software di terzi 

Adobe After Effects CC

After Effects CC

Visualizzare l’anteprima del video
Per visualizzare l’anteprima della tua composizione in tempo reale sul dispositivo 
Blackmagic Design, vai su Preferences > Video Preview. Spunta la casella Mercury Transmit 
per utilizzare l’hardware con After Effects CC. In Video Device seleziona Blackmagic Playback. 
Ora puoi visualizzare le composizioni di After Effects su un monitor broadcast con lo spazio 
colore corretto.
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Le Preferenze della visualizzazione di anteprima Video Preview

Se lavori con formati non supportati o meno comuni, puoi cambiare le impostazioni per 
visualizzare correttamente le immagini dal dispositivo Blackmagic Design. Vai su 
Preferences > Video Preview e clicca sulla dicitura gialla Setup. Apparirà una finestra di 
selezione, dove puoi ridimensionare l’immagine secondo lo standard video supportato 
dall’hardware. Per esempio, se utilizzi UltraStudio 4K e la composizione After Effects è 
impostata su una risoluzione 2048 x 1152, puoi ridimensionarla in minore risoluzione per  
la visualizzazione in 2K DCI, oppure in maggiore risoluzione per quella in Ultra HD.

Renderizzazione
Una volta completata la composizione, puoi renderizzare una sequenza immagine DPX  
o uno dei codec seguenti:

Opzioni di rendering in uscita Output Module Settings
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Codec QuickTime su Mac OS
 � Blackmagic RGB a 10 bit non compresso

 � Apple 4:2:2 YUV a 10 bit non compresso

 � Apple 4:2:2 YUV a 8 bit non compresso

 � Apple Photo - JPEG (compresso)

 � Apple DV - NTSC (compresso)

 � Apple DV - PAL (compresso)

Altri codec tra cui ProRes e DVCPRO HD sono disponibili con Final Cut Pro.

Codec AVI su Windows
 � Blackmagic 4:4:4 a 10 bit non compresso

 � Blackmagic 4:2:2 a 10 bit non compresso

 � Blackmagic 4:2:2 HD a 8 bit non compresso

 � Blackmagic 4:2:2 SD a 8 bit non compresso

 � Blackmagic MJPEG a 8 bit (compresso)

Altri codec tra cui DVCPRO HD e DVCPRO50 sono disponibili con Premiere Pro CC.

Codec QuickTime su Windows
 � Blackmagic RGB a 10 bit non compresso

 � Blackmagic a 10 bit non compresso

 � Blackmagic a 8 bit non compresso

 � Apple Photo - JPEG (compresso)

 � Apple DV - NTSC (compresso)

 � Apple DV - PAL (compresso)

Adobe Photoshop CC

Photoshop CC
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Importare ed esportare fotogrammi video

Importare un’immagine su Photoshop CC
1 Seleziona File > Import > Blackmagic Image Import.

2 Seleziona il formato dell’ingresso video Video Input Format, la profondità 
dell’immagine Image Bit Depth e clicca su Import Image.

Importazione dell’immagine

Esportare un’immagine da Photoshop CC
1 Seleziona File > Export > Blackmagic Image Export.

2 Seleziona il formato dell’uscita video Video Output Format e clicca su Export Image.

Esportazione dell’immagine

Queste opzioni di importazione ed esportazione si impostano solo la prima volta. Se vuoi 
cambiarle in futuro, la finestra riappare se tieni premuto il tasto Option (su Mac) o Ctrl  
(su Windows) quando selezioni Import o Export.

Adobe Premiere Pro CC

Premiere Pro CC
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Creare un progetto Blackmagic Design
1 Apri Premiere Pro e clicca su New project. Digita il nome del progetto e seleziona 

dove salvarlo.

2 Se la scheda grafica è compatibile con il motore di elaborazione Mercury Playback 
Engine di Premiere Pro CC, questa accelerazione GPU sarà visibile come opzione di 
render e consigliamo di selezionarla.

3 Nel menù a discesa Capture format, seleziona Blackmagic Capture. Su Mac o 
Windows, clicca Impostazioni e seleziona i parametri di acquisizione audio e video,  
tra cui lo standard video e il formato video. Clicca OK per ritornare alla finestra 
New Project.

4 Clicca sulla tab Dischi di memoria virtuale per selezionare dove salvare il video, 
l’audio, l’anteprima video e audio in entrata.Clicca OK e si apre il nuovo progetto.

5 Ora assicurati che l’audio di sistema di default non sia impostato su Blackmagic 
Desktop Video.

Su Mac OS, apri Preferenze di Sistema > Suono > Uscita e controlla che con sia 
selezionato il dispositivo Blackmagic. In Ingresso controlla che non sia selezionato  
il dispositivo Blackmagic come microfono di ingresso.

Su Windows, vai alla barra degli strumenti e fai clic destro sull’icona dell’altoparlante 
per aprire le impostazioni audio. Clicca sulla tab Riproduzione e seleziona gli 
altoparlanti interni o un dispositivo che non sia quello Blackmagic Design in uso.  
Clicca sulla tab Registrazione e seleziona un dispositivo che non sia quello 
Blackmagic Design in uso.

6 Su Adobe Premiere Pro, torna a Preferenze e seleziona Dispositivi Audio > Output 
predefinito > Uscita: Built-in Output. Alla voce Mapping output > Associa output per > 
Adobe Desktop Audio.

Nelle Preferenze di Adobe Premiere Pro, clicca sulla tab  
Dispositivi Audio, e imposta di default Uscita: Built-in Output  
per le voci Output Predefinito e Mapping Output
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7 In Preferenze, dalla tab Riproduzione, alla voce Dispositivi audio spunta la casella 
Blackmagic Playback. Premi OK.

Nelle Preferenze di Adobe Premiere Pro, clicca sulla tab 
Riproduzione > Dispositivi Audio > Blackmagic Playback, e spunta 
la casella Blackmagic Playback alla voce Dispositivo Video 

8 Per creare una nuova sequenza, clicca su File > Nuovo > Sequenza. Seleziona il 
predefinito Blackmagic desiderato, assegna un nome in Nome sequenza e clicca OK.

Crea una nuova sequenza dai predefiniti Blackmagic Design
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Controllo dispositivo
La maggior parte dei dispositivi di acquisizione e riproduzione Blackmagic Design intregrano 
una porta di controllo deck RS-422. Clicca su Preferenze > Controllo dispositivo e assicurati 
che il controllo del dispositivo Blackmagic sia selezionato alla voce Dispositivi. Clicca OK.

Riproduzione
Se lavori con formati non supportati o meno comuni, puoi cambiare le impostazioni per 
visualizzare correttamente le immagini dal dispositivo Blackmagic Design. Vai su 
Preferenze > Riproduzione e clicca sulla dicitura blu Impostazioni. Apparirà una finestra di 
selezione, dove puoi ridimensionare l’immagine secondo lo standard video supportato 
dall’hardware. Per esempio, se utilizzi UltraStudio 4K e la composizione Premiere è impostata 
su una risoluzione 3996 x 2160, puoi ridimensionarla in minore risoluzione per visualizzarla in 
Ultra HD, oppure in maggiore risoluzione per il 4K DCI.

Scegli cosa fare con i formati non supportati: non inviare  
(No output), ridimensiona in minore risoluzione (Scale down)  
o ridimensiona in maggiore risoluzione (Scale up)

Se il dispositivo Desktop Video è compatibile con l’HDR, per i progetti HDR puoi anche 
impostare il gamut di colori e la funzione di trasferimento. Le opzioni includono HLG e PQ per  
il Rec. 2020. Nel campo HDR mastering is for imposta il valore di nits più alto che la TV o il 
monitor sono in grado di visualizzare.

Acquisizione

Per l’acquisizione seleziona:
File > Acquisisci [F5]. 

Digita il nome del nastro e della clip.
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Regola le impostazioni di controllo dispositivo e acquisizione dalla tab Acquisizione

Per l’acquisizione immediata, o da un dispositivo non controllabile, clicca il pulsante rosso di 
registrazione, o il tasto [G].

Se preferisci registrare la clip tramite la porta di controllo RS-422, inserisci i punti di attacco  
e stacco con i pulsanti Imposta attacco e Imposta stacco, oppure inserisci manualmente il 
timecode e clicca Archivia clip. Digita il nome della clip e premi OK. La clip vuota apparirà nella 
finestra di progetto. Segui lo stesso procedimento per ogni clip che vuoi acquisire in batch. 

Poi seleziona: File > Acquisisci in batch [F6]. Per configurare le maniglie di attacco/stacco delle 
clip, abilita la funzione di acquisizione con maniglie, e digita il numero di fotogrammi addizionali 
desiderati all’inizio o alla fine di ogni clip. Poi clicca OK. Ora seleziona il nastro desiderato, 
clicca OK e le clip verranno acquisite.

Esportazione su nastro 
Per editare il progetto montato su un deck esterno, puoi utilizzare la funzione Esporta su 
cassetta di Premiere Pro. Scegli tra due tipi di esportazione: Inserisci e Assembla. Inserisci 
richiede un timecode ininterrotto per la durata del progetto che si vuole esportare su nastro,  
ed è un’ottima opzione per sostituire una ripresa su una cassetta esistente. Nella modalità 
Assembla si cancella il nastro fino a quando comincia il timecode della sequenza, quindi non  
va utilizzato se sul nastro sono stati già salvati altri progetti oltre il punto di stacco del tuo edit.

Usa la funzione Esporta su cassetta per esportare il tuo edit su un registratore esterno
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SUGGERIMENTO Se si esporta su nastro in modalità Assembla, consigliamo di 
aggiungere 30 secondi di video nero alla fine della sequenza. È utile una volta riavvolto 
il nastro per evitare che appaiano file multimediali indesiderati subito dopo la sequenza.

Per esportare su cassetta tramite il controllo deck RS-422:
1 Assicurati che le Preferenze di Adobe Premiere Pro siano configurate correttamente 

(consulta la sezione precedente “Creare un progetto Blackmagic Design”).

2 Apri la finestra di Premiere Pro Montaggio su nastro da File > Esporta > Cassetta 
(dispositivo seriale). In Opzioni, seleziona Blackmagic capture dal menù a discesa,  
e scegli lo stesso standard e formato video, e le impostazioni audio. Clicca OK.  
È importante che il formato di acquisizione corrisponda a quello di esportazione per 
evitare errori del deck durante il preroll con il risultato che l’audio non venga esportato.

3 Ora scegli il tipo di esportazione tra Inserisci e Assembla dal menù a discesa, inserisci  
il timecode di attacco e clicca Registra.

Per il montaggio su nastro, il software indica al deck il primo fotogramma del progetto per 
cominciare la registrazione secondo il timecode impostato. Se il primo fotogramma viene 
ripetuto o perso durante il procedimento, si consiglia di ri-sincronizzare deck e computer con 
Riproduzione > Dispositivo video > Offset. È necessario impostare la combinazione deck/
computer una volta sola, e il parametro verrà salvato in memoria.

Adobe Character Animator CC
Alcuni dispositivi di acquisizione e riproduzione Desktop Video consentono di inviare la grafica 
generata da Adobe Character Animator CC ad altri dispositivi video come i monitor di 
riferimento. Per esempio si può monitorare la performance di un personaggio virtuale nel video 
montato in tempo reale.

Questa sezione mostra come configurare i segnali in uscita su Adobe Character Animator CC. 

1 Su Adobe Character Animator, seleziona le impostazioni per i segnali in uscita del 
personaggio con Character > Preferences > Live Output.

2 Accertati di abilitare la casella Mercury con Enable Mercury transmit and syphon.

3 Spunta la casella di riproduzione Blackmagic playback. 

4 Seleziona Setup a fianco di Blackmagic playback per configurare la modalità di invio.

5 Dal menù a discesa Output mode scegli tra le seguenti modalità:
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Playback
Invia il segnale direttamente da Adobe Character Animator CC senza chiave per la riproduzione.

Internal Keying
Sovrappone il personaggio animato su un’altra sorgente video con il keyer interno del 
dispositivo Desktop Video. Per esempio, è possibile creare lo sfondo con il video di 
un’ambientazione pertinente alla storia, e sovrapporre il personaggio per dare vita a 
un’intervista in tempo reale. Oppure si può far reagire il personaggio ai contenuti trasmessi 
come un logo o una filigrana, sovrapposto al flusso video live in un angolo delle immagini.

Fill/Key
Per creare una chiave con uno switcher esterno, per esempio ATEM, seleziona questa opzione 
di riempimento/chiave. Il segnale di riempimento è il personaggio animato e il segnale di chiave 
è la maschera in scala di grigio che indica al keyer di creare uno spazio trasparente intorno al 
personaggio. In questo modo il keyer è in grado di sovrapporre il personaggio sullo sfondo.

Final Cut Pro X
L’opzione A/V Output su Final Cut Pro X consente di trasmettere il video in uscita tramite un 
dispositivo video Blackmagic Design. Se utilizzi un dispositivo Desktop Video compatibile con 
l’HDR, puoi visualizzare e montare il video HDR ad ampio gamut di colori su una TV o un 
monitor compatibili con questo formato.

Final Cut Pro X

Impostare Final Cut Pro X
1 Assicurati di utilizzare Final Cut Pro X 10.0.4 o successivo e la versione più recente 

di Mac OS.

2 Apri Blackmagic Desktop Video Setup. Dal menù a discesa Video standard seleziona  
il formato che intendi usare per il progetto su Final Cut Pro X, per esempio 2160p29.97. 
Il formato selezionato deve essere lo stesso di quello delle clip, e determina la modalità 
di monitoraggio dell’uscita video.

Seleziona un formato di uscita uguale al formato del progetto Final Cut Pro X
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3 Dal menù a discesa Pixel format seleziona un formato compatibile con la TV o con il 
monitor che intendi usare. Per esempio se lavori in HDR ad ampio gamut di colori, 
scegli 10-bit YUV 4:2:2 o 10-bit RGB 4:4:4 in base alle specifiche del monitor.

4 Dal menù a discesa Color gamut seleziona lo stesso gamut di colori del progetto.  
Per esempio se lavori in SD o HD con una gamma dinamica standard, scegli Rec. 601/
Rec. 709. Se utilizzi un dispositivo Desktop Video compatibile con l’HDR, e se svolgi il 
montaggio in 4K o in HDR, scegli Rec. 2020. Per i progetti sia in 4K che in HDR, scegli 
Rec. 2020 HLG o Rec. 2020 PQ. La TV o il monitor che intendi usare deve essere 
compatibile con questo formato.

Dopo aver definito queste impostazioni con Blackmagic Desktop Video Setup, puoi creare un 
nuovo progetto su Final Cut Pro X.

Per creare un nuovo progetto:
1 Apri Final Cut Pro X. In Library Properties, modifica il campo Untitled per assegnare un 

nome al progetto. Vai su File > New > Library per creare una nuova libreria.

SUGGERIMENTO Dopo aver creato una nuova libreria, le opzioni sulla destra 
sono nascoste. Clicca sull’icona del ciak in alto a sinistra per visualizzarle nella 
barra laterale.

2 Seleziona la nuova libreria dalla barra laterale e clicca sull’icona Modify corrispondente. 
Nella finestra di opzioni che appare, seleziona uno spazio colore per il progetto. Scegli 
Standard per i progetti SD o HD con un gamut di colori standard. Se intendi realizzare 
un video HDR ad ampio gamut di colori, scegli Wide Gamut HDR.

3 Conferma con Change.

4 Nella barra laterale, fai un clic destro sul nome della libreria e seleziona New Project. 
Digita un nome per il nuovo progetto e scegli un evento in cui collocarlo. Se non è stato 
creato nessun evento precedentemente, scegli quello di default, il cui titolo è la 
data corrente.

5 Seleziona Use Custom Settings. Imposta il formato video Format, la risoluzione 
Resolution e il frame rate Rate di modo che concordino con lo standard e il frame rate 
impostati su Blackmagic Desktop Video Setup.

6 Dal menù a discesa Rendering, seleziona il codec Apple ProRes o il 4:2:2 non 
compresso a 10 bit, a seconda del progetto.
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7 Se il progetto è in HD non è necessario cambiare lo spazio colore perché Final Cut Pro 
auto-seleziona Rec. 709 di default. Se il progetto è in HDR ad ampio gamut di colori, 
seleziona uno spazio colore scegliendo tra PQ e HLG in base alle specifiche della TV o 
del monitor.

8 Dal menù a discesa Channels, imposta i canali audio su Stereo, o su Surround nel caso 
di 6 canali. Dal menù a discesa Sample Rate, seleziona 48kHz.

9 Clicca su OK per creare un nuovo progetto. 

Se usi un monitor esterno HDMI o SDI, controlla che le immagini vengano visualizzate 
correttamente.

Per impostare l’uscita video su Final Cut Pro X:
1 Vai su Final Cut Pro > Preferences e apri la tab di riproduzione Playback.

Seleziona Blackmagic dal menù a discesa A/V Output e assicurati che lo standard 
video concordi con quello del progetto. Chiudi la finestra delle impostazioni.

2 Dalla barra del menù, seleziona Window > A/V Output per abilitare l’uscita video 
tramite il dispositivo video Blackmagic Design.

Per configurare l’uscita audio su Mac OS:
1 Apri Preferenze di Sistema e clicca sull’icona Suono.

2 Apri la tab Uscita e seleziona Blackmagic Audio.

SUGGERIMENTO L’audio si può monitorare anche sfruttando i dispositivi 
Desktop Video.

Riproduzione
1 Importa le clip sul nuovo progetto.

2 Ora puoi utilizzare la timeline di Final Cut Pro X sul tuo computer e visualizzare 
l’anteprima del video sul monitor o sulla TV collegati all’uscita del dispositivo 
Blackmagic Design.

Acquisire file video e audio
Per acquisire video e audio con i dispositivi video Blackmagic Design è possibile usare 
Blackmagic Media Express. Dopo aver acquisito le clip, importale su Final Cut Pro X per  
il montaggio.

Per l’acquisizione con Media Express è necessario selezionare un formato video compatibile 
con Final Cut Pro X, per esempio Apple ProRes 4444 XQ, ProRes 4444, ProRes 422 HQ, 
ProRes 422, ProRes 422 LT o 4:2:2 non compresso a 10 bit.

Esportazione su nastro
Una volta completato un progetto su Final Cut Pro X, puoi renderizzarlo come file e utilizzare 
Blackmagic Media Express per masterizzarlo su nastro con il dispositivo Blackmagic Design.

1 Seleziona le clip desiderate dalla timeline di Final Cut Pro X.

2 Vai su File > Share > Master file e si apre la finestra di masterizzazione.

3 Clicca sulle impostazioni Settings e seleziona il codec dal menù a discesa.
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4 Clicca Next… e seleziona dove salvare il file, poi salva con Save.

5 Apri Media Express e importa la clip esportata da Final Cut Pro X.

6 Consulta la sezione di Blackmagic Media Express “Montare file video e audio 
su nastro”.

Avid Media Composer
Avid Media Composer offre acquisizione e riproduzione di video e audio 4K con i dispositivi 
Blackmagic Design, e offre il supporto per il controllo deck RS-422. Se Media Composer è già 
installato sul computer, i relativi plug-in sono automaticamente scaricati prima del software 
Desktop Video.

Avid Media Composer

Configurazione
1 Apri Media Composer. Apparirà la finestra Select Project.

2 Scegli il profilo utente, se creato in precedenza.

3 Ora seleziona se salvare il tuo progetto come privato o condiviso, e se salvarlo sul 
computer o su un drive esterno.

4 Clicca sul pulsante New Project.

5 Digita il nome del progetto e seleziona le opzioni di formato, spazio colore,  
e stereoscopico. Clicca OK. È possibile cambiare le impostazioni dello spazio colore  
e stereoscopico in un secondo tempo sulla tab Format di progetto. 
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Digita il nome del progetto e seleziona le opzioni desiderate

6 Clicca due volte sul nome del progetto nella finestra di dialogo Select Project. 
Appaiono l’interfaccia di Media Composer e la finestra di progetto per il nuovo 
progetto. La configurazione del progetto è completa.

Riproduzione
Per controllare velocemente se tutto è collegato correttamente, vai su Help > Read Me > Media 
Composer Editing Guide. Nella sezione Importing Color Bars and Other Test Patterns clicca 
due volte sul file importato per riprodurlo. Ora dovrebbero apparire le immagini sul monitor del 
computer e sull’uscita del dispositivo Blackmagic Design.

Se non appaiono le immagini sull’uscita del dispositivo Blackmagic Design, controlla che tutti i 
cavi siano connessi, e che le impostazioni dell’uscita siano configurate correttamente su 
Blackmagic Desktop Video Setup in Media Composer > Tools > Hardware setup. Assicurati 
che compaia l’icona dell’hardware sopra la timeline.

NOTA Se utilizzi un dispositivo Blackmagic esterno come UltraStudio 4K, assicurati 
che sia alimentato e connesso prima di lanciare Media Composer.

Acquisizione da dispositivi non controllabili
Spesso i dispositivi di cattura, inclusi camere e registratori su disco moderni, videocamere 
datate e videoregistratori, non hanno l’opzione di controllo remoto. 

Per acquisire video senza controllo deck:

1 Seleziona File > Input > Tape Capture > Capture Tool.

2 Clicca sull’icona del deck per cambiarla nell’icona del satellite, composta dall’immagine 
del globo e il segno +. Questo simbolo indica che il controllo del dispositivo è disabilitato.
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Su Capture Tool, clicca sull’icona del deck finché non appare l’icona 
del satellite per acquisire video da dispositivi non controllabili

3 Seleziona le tracce audio e video che vuoi acquisire. Sono etichettate V, A1, A2 ecc. 
Dai menù a discesa sottostanti, seleziona Blackmagic per Video e Audio.

4 Dalla voce Bin seleziona la cartella dalla lista dei bin.

5 Dal menù della risoluzione Res, scegli quale codec utilizzare per le clip. In questo 
esempio, seleziona DNxHD175x per il video HD a 10 bit.

6 Scegli il disco di destinazione per l’audio e il video acquisito. Clicca sul pulsante del 
drive per salvare l’audio e il video insieme su un unico drive.  
Per salvarli separatamente, clicca di nuovo sul pulsante e appaiono due drive.  
Dal menù a discesa adiacente seleziona i drive dove salvare i file acquisiti.

7 Clicca sul pulsante Tape name? in basso alla finestra per aprire la finestra di dialogo 
Select tape. Digita il nome del nastro, o se l’hai utilizzato precedentemente, selezionalo 
dalla lista.

8 Accertati che le fonti audio e video siano pronte e attive, poi clicca sul pulsante di 
acquisizione. Il pulsante lampeggia di rosso durante la registrazione. Cliccalo di nuovo 
per terminare l’acquisizione.
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Acquisizione da dispositivi controllabili con UltraStudio, DeckLink, e Teranex
Se il tuo deck si collega tramite RS-422, prima di cominciare la registrazione segui le istruzioni 
seguenti per impostarlo correttamente.

1 Connetti un cavo seriale RS-422 dal dispositivo Blackmagic Design al tuo deck. 
Imposta il deck su Remote. Se utilizzi un dispositivo Blackmagic esterno, assicurati  
che sia alimentato e connesso prima di lanciare Media Composer. 

2 Dalla finestra di progetto, clicca sulla tab Settings > Deck configuration.

3 Dalla finestra di dialogo aggiungi un canale con Add channel e seleziona Direct.  
Poi seleziona Port > RS-422 deck control. Clicca su OK. Quando appare la richiesta  
di autoconfigurazione canale Do you want to autoconfigure the channel now?, 
clicca su No.

4 Ora aggiungi un deck Add deck e seleziona marca e modello dalla lista dei dispositivi 
disponibili, poi il preroll desiderato. Clicca OK e conferma con Apply.

5 Dalla tab Settings clicca due volte su Deck Preferences.

6 Abilita l’opzione Allow assemble edit and crash record for digital cut per assemblare 
gli edit sul nastro. Se questa opzione non è selezionata, potrai solo inserire gli edit 
singolarmente. Clicca OK.

SUGGERIMENTO Se Media Composer mostra l’errore Failed to find 
coincidence point on tape, puoi continuare spuntando la casella Relax 
coincidence point detection in Deck Preferences.

Nelle preferenze del deck, seleziona Relax  
coincidence point detection
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Per registrare velocemente con il controllo deck:
1 Seleziona File > Input > Tape Capture > Capture Tool. Se il deck collegato viene 

riconosciuto, e contiene un nastro o una cassetta, ti verrà richiesto di inserire il nome,  
o di selezionarlo dalla lista.

2 Il pulsante della fonte ora mostra l’icona del deck. Se il pulsante visualizza un satellite, 
cliccalo di nuovo per abilitare il controllo deck, e apparirà l’icona del deck. 

3 Dovrebbe anche visualizzarsi l’icona di acquisizione CAP, ma se al suo posto appare 
l’icona della matita di Log, clicca il pulsante per cambiare la modalità di acquisizione,  
e far riapparire CAP. 

4 Se appare No deck nella finestra del timecode, o il nome di un deck in corsivo sotto  
la finestra, clicca il menù a discesa e seleziona Check decks. Una volta ristabilito il 
controllo deck, il nome del deck riappare senza il corsivo. Ora è possibile utilizzare 
direttamente i tasti di scelta rapida J K L della tastiera.

5 Seleziona Blackmagic per l’ingresso audio e video. Seleziona le tracce audio e video,  
la cartella bin, la risoluzione, il drive di salvataggio e il nome della cassetta nello stesso 
modo della sezione Capture from non-controllable devices.

6 Utilizza la finestra di controllo deck in Capture Tool per far partire il nastro e cominciare 
la riproduzione.

7 Clicca il pulsante di acquisizione. Il pulsante lampeggia di rosso durante la 
registrazione. Cliccalo di nuovo per terminare l’acquisizione.

Seleziona le icone CAP e del deck per abilitare il controllo deck. Utilizza la  
finestra di controllo deck per far partire il nastro e cominciare la riproduzione
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Acquisizione in batch con UltraStudio e DeckLink
Per selezionare le clip per l’acquisizione in batch:

1 Seleziona File > Input > Tape Capture > Capture Tool.

2 Se appare l’icona del satellite, clicca il pulsante finché si visualizza l’icona del deck. 
Clicca sul pulsante CAP/Log per mostrare l’icona della matita di Log.

3 Imposta le tracce audio e video, la cartella bin di destinazione, la risoluzione, il drive  
di salvataggio e il nome della cassetta come nella sezione Capture from non-
controllable devices.

4 Usa la finestra di controllo deck, oppure i tasti J K L della tastiera per scorrere il video 
in avanti, indietro, o metterlo in pausa per trovare i punti di attacco e stacco del video 
che vuoi acquisire.

5 Clicca il pulsante di attacco e stacco a sinistra dell’icona della matita di Log. L’icona 
alterna tra In e Out, quindi basta cliccare sullo stesso pulsante per marcare i punti di 
attacco e stacco e salvare le clip. È un’opzione più veloce della finestra di controllo 
deck, dove si utilizzano due pulsanti diversi per In e Out. Oppure usa la tastiera:  
I e O per marcare i punti di attacco e stacco, e F4 per salvare le clip.

Clicca sui pulsanti di attacco/stacco o usa i tasti I e O della tastiera

6 Una volta fatto il log delle clip, chiudi Capture Tool, apri la cartella bin delle clip salvate 
e seleziona quelle che vuoi acquisire.

7 Dal menù Clip, seleziona Batch capture, le opzioni desiderate nella finestra di 
dialogo, e OK.
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Esportazione su nastro con UltraStudio e DeckLink
Una volta acquisite le clip, trascinate sulla timeline, editate, e applicati e renderizzati gli effetti,  
si può esportare l’intero progetto su nastro.

1 Clicca due volte sulla sequenza, e si apre sulla finestra della timeline.

2 Seleziona File > Output > Digital Cut > Digital Cut Tool.

3 Seleziona la modalità in uscita Output mode in tempo reale Real time, e la profondità  
di bit Bit depth > 10-bit. Seleziona Entire Sequence per registrare l’intera sequenza,  
e la modalità di controllo deck Deck Control > Remote.

4 Ora seleziona una delle due opzioni, Insert Edit o Assemble Edit per esportare l’edit  
su un nastro precedentemente cancellato e contenente le righe di timecode. Oppure 
per un’esportazione immediata, scegli Crash Record. Se Insert edit è l’unica opzione 
disponibile, vai alla tab delle impostazioni di progetto e clicca su Deck preferences > 
Allow assemble edit & crash record for digital cut.

5 Se il nome del deck appare in corsivo, o vedi la scritta No deck, clicca sul menù e 
seleziona Check Decks. Il nome del deck dovrebbe apparire senza il corsivo 
confermando che il controllo deck è attivo.

6 Premi il pulsante rosso di Play per registrare la sequenza su nastro.

Apri la finestra Digital Cut Tool per registrare su nastro
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Autodesk Smoke
Autodesk Smoke include strumenti per montaggio, compositing ed effetti 3D in un unico 
programma. Smoke offre acquisizione e riproduzione di video e audio SD e HD con i dispositivi 
Blackmagic Design, e supporta il controllo deck RS-422. 

Autodesk Smoke

Impostare un VTR
Prima di avviare Autodesk Smoke, dall’utilità Smoke Setup è necessario selezionare il modello 
del VTR utilizzato e configurare le impostazioni di temporizzazione.

1 Vai su Applicazioni > Autodesk > Smoke 2018 > Utility > Smoke Setup.

2 Nella tab General, seleziona BMD alle voci Video device e Audio device.

3 Nella tab Vtr abilita il modello VTR e la temporizzazione desiderati per l’uso con 
Autodesk Smoke. Spunta le voci Live NTSC o Live PAL per abilitare la registrazione 
immediata o l’invio dei segnali live.

4 Conferma con Apply e chiudi Smoke Setup.

Sull’utilità Smoke Setup, seleziona BMD per  
Video Device e Audio Device
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Operazioni preliminari
1 Apri Smoke e apparirà la finestra di impostazioni. Clicca su Project e User se impostati 

in precedenza, oppure crea un nuovo progetto e/o utente.

2 Seleziona gli stessi parametri di consegna, per es. 1080HD. Potrai cambiare questi 
setting in un secondo tempo.

3 Scegli il formato intermedio, per esempio ProRes 422 HQ o uncompressed per i file 
generati durante il progetto. È importante scegliere il formato adatto al sistema di 
archiviazione in uso.

4 Clicca il pulsante Create.

Configurare l’hardware
Consigliamo di seguire i seguenti passi prima di cominciare il processo di acquisizione con VTR.

1 Connetti le uscite del VTR agli ingressi del dispositivo di acquisizione e riproduzione 
Blackmagic Design. Connetti le uscite del dispositivo di acquisizione e riproduzione 
Blackmagic Design agli ingressi del VTR.

2 Con un cavo connetti la porta di controllo remoto RS-422 del dispositivo 
Blackmagic Design alla porta seriale del VTR. 

3 Imposta il VTR su Remote. 

4 Connetti un generatore di sync all’ingresso sync del VTR per un’acquisizione accurata a 
livello di frame. 

Se utilizzi un dispositivo audio separato, anche questo va collegato a un segnale di sync audio.

Digita il nome del progetto e seleziona le opzioni desiderate
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Acquisizione da dispositivi controllabili da UltraStudio e DeckLink
Autodesk Smoke si può configurare per l’acquisizione da VTR controllabili tramite la 
porta RS-422.

1 Seleziona una cartella dall’archivio multimediale dove salvare le clip acquisite.

2 Seleziona File > Capture from VTR, e appare il modulo di acquisizione del VTR.

Sull’utilità Smoke Setup, seleziona BMD per Video Device e Audio Device

3 Clicca su Cue sul primo fotogramma della clip che vuoi acquisire.

4 Seleziona il video e i canali audio che vuoi registrare. I pulsanti diventano rossi per 
mostrare quali tracce sono abilitate.

Le tracce audio e video diventano rosse quando sono abilitate per l’acquisizione dal VTR

5 Clicca i pulsanti In e Out per selezionare l’inizio e la fine della traccia. 

6 Premi il pulsante di acquisizione e il timecode diventa verde confermando che 
l’acquisizione è in corso.

7 Termina l’acquisizione in qualsiasi momento cliccando all’interno della finestra di 
anteprima. La clip si salva automaticamente nella cartella selezionata prima di aprire  
il modulo VTR.

Esportazione su nastro con UltraStudio e DeckLink
Carica una clip nella sezione VTR e seleziona i punti di attacco In e stacco Out per la clip da 
esportare. È anche possibile ritardare il fotogramma iniziale, e applicare un overlay letterbox.

1 Seleziona File > Output to VTR.

2 Scegli le clip da esportare dall’archivio multimediale. Se preferisci puoi selezionare una 
cartella ed esportarne l’intero contenuto in una sola sessione. Appare la sezione di 
esportazione VTR.
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Seleziona il nome del VTR dal menù a discesa

3 Seleziona il nome del VTR dal menù a discesa. La finestra di anteprima mostra il video 
dal nastro nel VTR selezionato.

4 Assicurati di abilitare i pulsanti della traccia video e dei canali audio corretti, cosicché 
questi siano esportati su nastro.

5 Dal menù Clip Output abilita o disabilita All Audio. Questa selezione fa sì che ogni 
canale audio si converta al formato del nastro, non solo quelli selezionati.

6 Clicca Preview per guardare la clip prima di esportarla.

7 Per esportare la clip selezionata a partire da un fotogramma che non sia il primo, 
inserisci il timecode di partenza in Start Offset.

Le clip selezionate per l’esportazione appaiono come lista con lo stato corrente

8 Seleziona i punti di attacco In e di stacco Out per le clip da esportare.

Seleziona i punti di attacco e di stacco delle clip, poi seleziona Insert dal menù a discesa di Output

9 Per esportare le clip sul VTR, seleziona Insert e verranno salvate su nastro. Durante 
l’esportazione, lo stato di ogni clip si aggiorna in Pending (in attesa), Output 
(esportazione in corso), e Done a fine esportazione.

10 Seleziona il timecode In poi premi Play per assicurarti che l’esportazione sia andata  
a buon fine.

11 Una volta completata, clicca su Exit Output Clip per chiudere la sessione.
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Registrazione immediata e acquisizione live
Autodesk Smoke consente di acquisire il segnale di un video live o di registrare una clip a 
scelta utilizzando una penna per tablet o un mouse per marcare i punti di attacco e di stacco. 
Per questo tipo di acquisizione, Autodesk Smoke fa una ricerca della memoria residua sul 
supporto dove si salvano i file multimediali di Autodesk, che dipenderà dal formato intermedio 
selezionato.

Inoltre se utilizzi un dispositivo che non supporta il controllo remoto tramite RS-422, per 
esempio una videocamera o un videoregistratore, puoi selezionare l’opzione Live NTSC  
o Live PAL per l’acquisizione, e Live Video per l’invio in uscita delle clip live.

Spunta le voci Live NTSC o Live PAL per abilitare la 
registrazione immediata o l’invio dei segnali live

Per registrare immediatamente il video live:
1 Scegli una cartella dall’archivio multimediale dove salvare le clip acquisite.

2 Seleziona File > Capture from VTR, e appare il modulo di acquisizione del VTR.

3 Dalla finestra Vtr, seleziona Live NTSC o Live PAL e il video live appare nella finestra  
di anteprima.

4 Seleziona la modalità Start on Pen, e per terminare l’acquisizione Stop on Pen o Stop 
on Frames. Questa terminologia deriva da quando Autodesk Smoke veniva operato 
con un tablet e penna.

Quando selezioni Stop on Pen per terminare l’acquisizione, i campi Out e Duration del 
timecode si aggiornano per mostrare la durata massima di registrazione residua della 
clip sulla memoria di Autodesk. L’acquisizione termina quando clicchi su qualsiasi parte 
dello schermo, o quando la memoria è piena.

5 Digita il nome della clip e abilita le tracce video e i canali audio da acquisire.

6 Assicurati di ricevere correttamente il segnale video.

7 Premi il pulsante di Play sul dispositivo video.

8 Clicca su Process per cominciare l’acquisizione,

9 e su qualsiasi parte dello schermo per terminarla, in modalità Stop on Pen. 
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Per inviare il segnale del video live:
1 Seleziona File > Output to VTR.

2 Scegli le clip da esportare dall’archivio multimediale. Se preferisci puoi selezionare una 
cartella ed esportarne l’intero contenuto. Appare la sezione di esportazione VTR.

Seleziona Live NTSC o Live PAL

3 Dalla finestra Vtr, seleziona Live NTSC o Live PAL

(Start Mode non è disponibile. Con la modalità Live va utilizzato il setting di default  
Start on …). Puoi terminare l’esportazione con Stop on Pen o Stop on Frames.

Usa l’impostazione di default Start On… per l’esportazione live

4 Imposta le opzioni di esportazione, per esempio digita il nome della clip e abilita  
le tracce video e i canali audio da acquisire. 

5 Sul dispositivo che riceve il segnale, avvia la registrazione, o fai il necessario per 
abilitare la ricezione del segnale da Autodesk Smoke.

6 Seleziona Process per avviare l’esportazione da Autodesk Smoke.

7 Clicca su qualsiasi parte dello schermo per terminarla, in modalità Stop on Pen.
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Blackmagic Media Express

Introduzione a Blackmagic Media Express
Il software Blackmagic Media Express è incluso ai prodotti UltraStudio, DeckLink, Intensity,  
agli switcher ATEM, Blackmagic Camera, H.264 Pro Recorder, ai convertitori Teranex e 
Universal Videohub. Media Express è un’ottima soluzione per acquisizione, riproduzione, ed 
esportazione delle clip su nastro senza le complessità dei software NLE. 

Acquisire file video e audio

Impostare un progetto
Media Express rileva automaticamente il formato video in entrata, e imposta il formato di 
progetto corrispondente. Per impostare manualmente il formato di progetto:

1 Su Mac, vai su Media Express > Preferences, oppure su Windows e Linux seleziona 
Edit > Preferences. Scegli il formato video di progetto dal menù a discesa di 
Project Video Format. Le opzioni includono formati compressi e non compressi. 
Dal menù Capture File Format puoi anche selezionare una sequenza di immagini DPX. 
Il video si salva nel formato scelto come file QuickTime. Puoi anche selezionare 
l’acquisizione di una sorgente RGB con un codec YUV e viceversa.

Usa la finestra Preferences per impostare vari parametri, 
inclusi il formato video di acquisizione e la destinazione
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2 Scegli dove salvare l’audio e il video acquisito. Clicca su Browse e scegli una cartella 
nel computer.

3 Scegli se continuare l’acquisizione in presenza di drop frame.

I progetti in SD utilizzano il rapporto d'aspetto 4:3, ma puoi spuntare la casella Use Anamorphic 
SD 16:9 per selezionare il rapporto 16:9 per SD anamorfico. 

Solitamente le applicazioni interrompono la riproduzione del video se vengono poste in 
secondo piano. Se preferisci che Media Express continui comunque a riprodurre il video anche 
quando è aperta un’altra applicazione, spunta Continue playback when in the background.

L’ultimo campo riguarda i registratori a nastro con controllo RS-422, e include le funzioni di 
preroll e offset.

Acquisizione
È facile acquisire il video. Connetti la sorgente video, e quando Blackmagic Media Express 
rileva l’ingresso clicca sul pulsante Capture.

Inserisci la descrizione del video

Bin delle  
clip

Opzioni di  
acquisizione

Controlli di  
trasporto 

Salva 
fotogramma

Nome progetto,  
formato video  
e frame rate

Spia di  
registrazione  

remota

Informazioni  
di  

salvataggio

Attacco /  
Stacco

Livelli  
audio

Abilita /  
disabilita 

canale audio

Libreria multimediale Campo di ricerca
Visualizzazione file per lista, 

thumbnail, e clip preferite Timecode VTR / deck Anteprima video
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1 Collega la sorgente video a un ingresso del dispositivo Blackmagic Design.  
Apri Desktop Video Setup e in Input connection assicurati di selezionare la stessa 
connessione della sorgente video (SDI, HDMI, a componenti, ecc.).

2 Apri Media Express e clicca sulla tab rossa Log and Capture.

3 Il video appare nel pannello di anteprima di Media Express, inserisci una descrizione 
nel campo Description.

4 Clicca il pulsante + a lato della descrizione per farla apparire automaticamente nel 
campo Name. Clicca il pulsante + a lato dei campi che vuoi aggiungere 
automaticamente nel campo Name.

 � Per incrementare il valore di ognuno di questi campi, clicca sull’icona di ciak 
corrispondente. Oppure inserisci manualmente nomi e numeri nei campi desiderati.

 � Il testo nel campo Name si applica a tutte le clip che saranno acquisite.

 � Per salvare la clip come preferita, clicca sulla stella a lato del campo del nome.

 � Per far apparire il nome della clip prima di ogni acquisizione, clicca su ! a lato del 
campo del nome.

5 Seleziona il numero di canali audio che vuoi acquisire.

Seleziona il numero di canali audio che vuoi acquisire

6 Clicca Capture per avviare l’acquisizione. Per terminare l’acquisizione e salvare la clip, 
clicca di nuovo il pulsante Capture o premi il tasto Esc. Le clip si vanno ad aggiungere 
alla lista dei file sulla sinistra di Media Express.

Clicca Capture per avviare l’acquisizione

Se il formato video in entrata è differente da quello di progetto, Media Express lo rileva 
automaticamente, e suggerisce di salvare il progetto corrente e crearne uno nuovo.

Blackmagic Media Express rileva automaticamente se 
cambia il formato sull’uscita di programma di ATEM, e offre 
l’opzione di salvare il progetto e crearne uno nuovo
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Indicizzare le clip
Connetti un cavo seriale RS-422 dal dispositivo video Blackmagic Design al deck. 

Assicurati che l’interruttore del deck sia abilitato su Remote. Utilizza i tasti di scelta rapida J K L 
per scorrere il video in avanti o indietro o metterlo in pausa.

 � Premi I per selezionare il punto di attacco, o il pulsante a lato di In.

 � Premi O per selezionare il punto di stacco, o il pulsante a lato di Out.

 � Premi P o clicca sul pulsante Log Clip. La clip dovrebbe ora apparire nella lista dei file 
con un’icona X a indicare che la clip è offline.

Acquisizione in batch
Dopo aver indicizzato una clip singola, puoi acquisirla cliccando sul pulsante Clip.

Per acquisire più clip in una volta sola, continua a indicizzare le clip per l’acquisizione in batch.

Seleziona le clip dalla lista ed esegui una delle azioni seguenti:

 � Clicca sul pulsante Batch.

 � Fai clic destro sulle clip prescelte e seleziona Batch Capture.

 � Vai sul menù File > Batch Capture.

Ora Media Express acquisisce la clip seguendo il timecode In/Out.

Acquisizione DPX
Per acquisire una sequenza di immagini DPX invece di un file .mov, apri Preferences di Media 
Express e seleziona Capture File Format > DPX 10-Bit RGB.

 � Crea un progetto DPX impostando il formato di acquisizione su DPX.

 � Acquisisci.

Preferenze di acquisizione nel formato DPX

Ad acquisizione completata, appare una singola thumbnail per l’intera sequenza nella lista dei 
file multimediali. La sequenza di fotogrammi DPX si salva in una cartella nel drive di memoria. 
L’audio si salva in un file .wav nella stessa cartella.

L’acquisizione di DPX è selezionata di default su Capture from a YUV source. Se la fonte è 
RGB, clicca su Capture from an RGB source. 

Se invece di cominciare da zero vuoi numerare i fotogrammi DPX secondo il timecode del video 
acquisito, seleziona Use absolute frame numbering when capturing DPX.

Se non esegui acquisizioni DPX di lunga durata, è possibile ridurre il numero di zeri della 
numerazione dei fotogrammi selezionando When capturing DPX files, use (2-8) digit numbers 
in the frame count.
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Acquisizione 3D
Se utilizzi Media Express con dispositivi video Blackmagic Design compatibili con il 3D dual 
stream, puoi creare clip 3D per l’occhio destro e sinistro, acquisendo 2 flussi di video HD-SDI 
contemporaneamente.

 � Crea un progetto 3D con lo stesso frame rate della sorgente video 3D dual stream.

 � Quando acquisisci da SDI, assicurati di connettere la fonte a un dispositivo video 
Blackmagic che dispone di due ingressi HD-SDI separati.

 � Acquisisci.

Seleziona un formato di progetto 3D per acquisire 
clip video in 3D stereoscopico dual stream

Quando acquisisci e indicizzi i file 3D dual stream su Media Express, il nome della clip si applica 
al video per l’occhio sinistro. Quello per l’occhio destro include il suffisso _right. Per esempio, 
per la clip stereo a cui hai assegnato il nome Clip 1, la clip per l’occhio sinistro appare come  
Clip 1.mov e la clip per l’occhio destro come Clip 1_right.mov.

La lista dei file multimediali mostra a colpo d’occhio se la clip acquisita è 3D:

 � In modalità thumbnail, le clip per l’occhio destro e sinistro sono connesse da un 
indicatore di 3D e visualizzate come un’unica, grande icona.

 � In modalità timecode, le clip per l’occhio destro e sinistro sono connesse da un 
indicatore di 3D.

In modalità thumbnail, le clip per l’occhio destro  
e sinistro sono connesse da un indicatore di 3D  
e visualizzate come un’unica, grande icona
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Bin delle clip Clip  
preferite

Controlli di 
trasporto

Salva 
fotogramma

Nome progetto,  
formato video  
e frame rate

Spia di 
registrazione 

remota

Dettagli  
clip

Attacco / 
Stacco

Livelli  
audio

Abilita /
disabilita 
canale 
audio

Libreria multimediale Campo di ricerca
Visualizzazione file per lista, 

thumbnail, e clip preferite Timecode VTR / deck Anteprima video

Riprodurre file video e audio

Riproduci clip singole o multiple
Per riprodurre una clip singola, clicca due volte sulla clip dalla lista dei file multimediali. Oppure 
seleziona la clip dalla lista e premi la barra spaziatrice sulla tastiera, o il pulsante di Play dai 
comandi di trasporto.

Usa i comandi di trasporto per avviare la clip, metterla in pausa, saltare  
a quella precedente o successiva, e riprodurre in loop

Per riprodurre più clip, selezionale dalla lista e premi la barra spaziatrice sulla tastiera,  
o il pulsante di Play dai comandi di trasporto.

Il video si riproduce sul pannello di anteprima di Media Express e su tutte le uscite del 
dispositivo video Blackmagic Design. Durante la riproduzione, i canali audio monitorati si 
possono attivare o disattivare con i relativi pulsanti sulle tracce audio.

Importare le clip
Dopo aver importato i file audio e video su Media Express, puoi riprodurli in vari modi:

 � Clicca due volte su uno spazio vuoto della lista dei file, seleziona il file che vuoi 
riprodurre e apri con Open.

 � Fai clic destro su un’area vuota della lista dei file, e seleziona Import Clip dal menù 
contestuale.

 � Vai su File > Import > Media Files.
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Seleziona le clip video e audio da importare e apri con Open. Le clip appariranno nell’area 
Scratch della lista dei file. Se hai creato cartelle bin personalizzate nella lista, trascina le clip nel 
bin desiderato.

Oppure fai clic destro sulla cartella bin e seleziona Import Clip dal menù contestuale.

Se il frame rate e le dimensioni dei file importati non corrispondono a quelli della lista dei file 
esistente, ti verrà suggerito di creare un nuovo progetto e di salvare quello corrente.

Se i parametri delle clip importate non corrispondono a quelle 
esistenti ti verrà suggerito di creare un nuovo progetto

SUGGERIMENTO Media Express supporta l’importazione di file multicanale di solo 
audio registrati a 48kHz nei formati non compressi Wave e AIFF.

Un altro metodo è importare i file XML da un software NLE come Final Cut Pro 7 o Final Cut Pro 
X. Vai su File > Import e seleziona un XML Final Cut Pro 7 o Final Cut Pro X. Apri il file XML e 
appariranno tutte le cartelle bin e i file multimediali del progetto Final Cut Pro nella lista dei file.

Media Express è compatibile anche con i file CMX EDL, per importare le clip in batch tramite  
i file EDL di altri programmi video. Vai su File > Import > CMX EDL. Seleziona l’EDL e aprilo. 

Importa i file singoli, oppure importa un XML o un EDL

Le informazioni relative ai file appaiono nelle lista. Seleziona le clip importate e acquisiscile in 
batch dal deck.
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Visualizzare i file multimediali

Anteprima thumbnail
Le thumbnail sono il modo più intuitivo di visualizzare le clip. Posiziona il cursore del mouse 
sulla thumbnail e clicca sull’icona pop-up in basso a destra della thumbnail. Clicca sulla finestra 
delle informazioni per nasconderla.

Clicca sull’icona pop-up per visualizzare le informazioni relative alla clip

Layout a lista
Per visualizzare le clip secondo la lista timecode, clicca sulla prima icona a sinistra. Utilizza la 
barra di scorrimento per visualizzare tutte le colonne di informazioni delle clip.

Scegli se visualizzare i file multimediali come lista secondo il timecode, 
o come anteprima thumbnail. Clicca sulla stella per mostrare solo 
le clip preferite. Digita il nome delle clip nel campo di ricerca

Creare e utilizzare i bin
Per creare una cartella bin, fai clic destro su un’area vuota all’interno della lista dei file e 
seleziona Create Bin. Assegna un nome al nuovo bin.

Puoi spostare le clip trascinandone le icone direttamente nel bin, oppure per inserire la stessa 
clip in più bin, fai un clip destro sul bin desiderato e seleziona Import clip.

Di default le clip indicizzate appaiono nella sezione Scratch. Per far apparire le clip importate 
direttamente in un nuovo bin, fai clic destro sulla cartella bin desiderata e seleziona Select 
as log bin.

Marcare e utilizzare le clip preferite 
Nella tab Log and Capture clicca l’icona della stella sulla destra di Name per etichettare la clip 
come preferita.

Nella tab Playback clicca l’icona della stella per etichettare la clip come preferita quando  
è selezionata dalla lista. Clicca di nuovo sulla stella per deselezionarla come preferita.
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Le clip preferite mostrano una stella gialla sull’icona sia in modalità thumbnail sia con 
layout a lista.

Una volta marcate le clip desiderate come preferite, clicca sul pulsante della stella in alto  
alla lista. L’icona della stella diventa gialla, e la lista delle clip si aggiorna per mostrare solo 
quelle preferite. 

Nella tab Log and Capture clicca l’icona della stella a lato del 
nome della clip per etichettarla come preferita

Associare una clip audio a una clip video
Per associare una clip audio a una clip video dalla lista dei file:

 � Seleziona una clip video che non contiene canali audio.

 � Fai clic destro sulla clip e seleziona Link audio file dal menù contestuale.

 � Cerca e seleziona il file audio desiderato e clicca su Open. Ora l’audio e il video sono 
associati nella libreria.

La lista dei file mostra chiaramente quando  
audio e video sono associati

Ora puoi riprodurre la clip video con audio o masterizzarla su nastro.

Eliminare clip e bin
Per eliminare le clip, selezionale e premi il tasto di ritorno della tastiera. 

Questa operazione elimina le clip dalla libreria, ma non dal disco di archiviazione.

Per eliminare una cartella bin e le clip al suo interno, fai clic destro e seleziona Delete bin. 
Questa operazione elimina le clip dalla libreria, ma non dal disco di archiviazione.
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Creare una clip 3D
Per aggiungere una clip in 3D stereoscopico alla lista dei file:

 � Seleziona lo stesso formato video 3D e frame rate di progetto del file 3D.

 � Importa il file per l’occhio sinistro nella lista.

 � Fai clic destro sul file per l’occhio sinistro e seleziona Set right eye clip dal menù 
contestuale per selezionare la clip per l’occhio destro. Se il file per l’occhio destro è 
stato acquisito con Media Express, la clip appare con il suffisso _right.

Seleziona un formato video 3D di progetto dalla lista

La lista dei file mostra chiaramente se la clip importata è 3D. Le clip per occhio sinistro e destro 
si visualizzano affiancate nella finestra di anteprima, confermando che si tratta di un progetto 3D.

La lista dei file mostra chiaramente  
se la clip importata è 3D

Se ti accorgi che le clip 3D stereoscopiche sono state assegnate al contrario (occhio sinistro 
invece di destro, o viceversa):

 � Fai clic destro sulla clip 3D dalla lista.

 � Inverti l’occhio destro con quello sinistro selezionando Swap Eyes dal menù 
contestuale.

Fare un ricerca nella libreria multimediale
Digita il nome della clip nel campo di ricerca in alto alla libreria multimediale. Inoltre 
puoi selezionare solo le clip preferite, per limitare ulteriormente la ricerca.

Digita il nome delle clip nel campo di ricerca
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Modalità  
registrazione

Masterizzazione 
su nastro

Abilita / disabilita 
canale audio

Attacco / Stacco

Montare file video e audio su nastro
Quando si parla di masterizzazione o di montaggio su nastro, non importa se il deck usa una 
cassetta a nastro o altri dischi di archiviazione. Per masterizzare le clip:

 � Seleziona le clip da masterizzare.

 � Clicca sulla tab Edit to Tape.

 � Seleziona il punto di attacco e il tipo di importazione.

 � Masterizza su nastro.

Selezionare le clip per la masterizzazione
Dalla libreria multimediale, seleziona le clip da masterizzare. Puoi anche scegliere clip di solo 
audio per sostituire la colonna sonora di master esistente sul nastro di master. Se vuoi 
masterizzare solo le clip preferite, clicca sull’icona della stella in alto alla libreria multimediale 
per mostrare solo queste. Poi scegli quali masterizzare.

Clicca sulla stella in alto alla libreria multimediale per  
visualizzare solo le clip preferite

Esportare su nastro
Clicca sulla tab Edit to Tape. Seleziona il punto di attacco del nastro inserendo il timecode alla 
voce In:, o posizionando il nastro dal punto desiderato con i controlli di trasporto. Clicca sul 
pulsante a sinistra per marcare il punto di attacco.

Se nessun valore è inserito alla voce Out:, Media Express legge automaticamente la durata 
totale delle clip nella libreria multimediale. Se il punto di stacco è definito, Media Express 
termina la registrazione una volta raggiunto il timecode relativo, anche se non tutte le clip sono 
state esportate.
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Due clip sono state selezionate per il mastering su nastro

Scegli se masterizzare su nastro usando l’opzione Assemble o Insert. Poi premi il 
pulsante Master.

L’opzione Preview simula il processo di montaggio, ma non registra su nastro. È utile per 
controllare i punti di attacco e di stacco, ed è consigliata per visualizzare le operazioni sui 
monitor connessi direttamente all’uscita del deck, per esempio il video già sul nastro e 
quello nuovo. 

Se è abilitata l’opzione di blocco registrazione sul deck o sul supporto di archiviazione, Media 
Express ti avvisa quando premi il pulsante Master. Disabilita il blocco registrazione, e ritenta la 
masterizzazione.

Seleziona il video e il numero di canali audio che desideri esportare cliccando sui pulsanti di 
attivazione/disattivazione delle tracce. Deseleziona il canale video V se vuoi esportare 
solo audio.

Seleziona il numero di canali audio che vuoi masterizzare

Clicca sulla stella in alto alla libreria multimediale per visualizzare solo le clip preferite.

Due clip sono state selezionate per il mastering su nastro.

Seleziona il numero di canali audio che vuoi masterizzare.

Acquisire video H.265
Per acquisire video H.265 con il codificatore interno di Blackmagic UltraStudio 4K Extreme:

1 Apri Preferences su Media Express e seleziona il formato di acquisizione Capture File 
Format > MP4 H.265.

2 Seleziona il bitrate per l’acquisizione in H.265 cliccando sul pulsante Quality a lato del 
formato di cattura. Aprirà la finestra Encoding Settings dove puoi trascinare lo slider 
del bitrate. Chiudi la finestra per salvare il valore scelto. 

SUGGERIMENTO Per maggiori informazioni sull’acquisizione in H.265 e sulle 
impostazioni di bitrate, consulta la sezione seguente “Hardware di codifica H.265”.
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Hardware di codifica H.265

Acquisire video H.265 con UltraStudio 4K Extreme
Blackmagic UltraStudio 4K Extreme integra un potente hardware di codifica in grado di 
acquisire il video H.265 di ultima generazione in tempo reale. In termini pratici consente di 
acquisire video con una tecnologia di codifica che mantiene la massima qualità video con  
il minore bitrate possibile.

Per acquisire video H.265 con UltraStudio 4K Extreme, seleziona MP4 
H.265 come formato di acquisizione su Media Express 

Per acquisire video con l’hardware di codifica H.265 integrato:
1 Lancia Blackmagic Media Express. Apri Preferences su Media Express e seleziona il 

formato di acquisizione Capture File Format > MP4 H.265.

2 Seleziona il bitrate per l’acquisizione in H.265 cliccando sul pulsante Quality a lato del 
formato di cattura. Si aprirà la finestra Encoding Settings dove puoi trascinare lo slider 
del bitrate. Chiudi la finestra per salvare il valore scelto. Blackmagic UltraStudio 4K 
Extreme è pronto all’acquisizione di video H.265 con Blackmagic Media Express. 
Per maggiori informazioni sull’acquisizione e riproduzione del video con Media Express, 
consulta la sezione “Blackmagic Media Express” del manuale.

Impostare il bitrate
Con il bitrate 15 Mb/s di default si ottiene video Ultra HD di ottima qualità per lo streaming 
online. È anche possibile selezionare valori di bitrate tra 50 Mb/s e 50 Mb/s. Per lo streaming 
online del video HD, è sufficiente un bitrate tra i 3 Mb/s e i 5 Mb/s.

Sposta lo slider di Encoding Settings verso sinistra se desideri acquisire video con dimensioni 
minori e bitrate minori, o verso destra per video della migliore qualità e file di maggiori 
dimensioni. Impostando un bitrate troppo basso saranno visibili effetti indesiderati dovuti alla 
compressione, per esempio striature, immagini pixellate, o macroblocchi. Nota che l’hardware  
di codifica H.265 è molto efficiente nel minimizzare gli artefatti di compressione, quindi 
selezionando un bitrate minore di quanto necessario per il H.264 si ottiene video di ottima qualità.
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Seleziona il bitrate per l’acquisizione in H.265 cliccando sul pulsante Quality  
a lato del formato di cattura. Poi in Encoding Settings trascina lo slider

Quando si comprime il video in H.265 (o in un altro formato) per lo streaming online, è utile 
considerare anche i parametri seguenti: la larghezza di banda del sistema di diffusione, quanto 
movimento e contrasto è presente tra le immagini, e il frame rate del video. Per esempio, se ci 
si aspetta che numerosi utenti accedano allo streaming è necessario limitare il bitrate della 
compressione di modo che quelli con connessioni internet lente siano in grado si visualizzare  
il video senza interruzioni. Un bitrate più elevato è adatto a contenuti con molto contrasto e 
movimento, per esempio immagini che passano da scarsa illuminazione alla piena luce del sole, 
o per gli eventi sportivi e la grafica. Il video con frame rate elevati richiede un bitrate maggiore 
rispetto ai frame rate più bassi.

È spesso necessario sperimentare con diversi valori di bitrate per ottenere il migliore rapporto 
tra qualità video e dimensioni dei file.

Blackmagic Disk Speed Test

Che cosa è Blackmagic Design Disk Speed?
Blackmagic Disk Speed Test misura la prestazione di riproduzione (lettura) e di registrazione 
(scrittura) dei supporti di memoria. I risultati appaiono in valori di risoluzione video. Disk Speed 
Test è incluso al software Desktop Video, e si scarica dall’App Store per macOS. Accedi alle 
impostazioni di Disk Speed Test dall'icona dell'ingranaggio, situata sopra il pulsante Start.

Select Target Drive
Seleziona il disco rigido. Accertati di avere l'autorizzazione di lettura e scrittura del 
disco selezionato.
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Save Screenshot
Salva lo screenshot dei risultati. 

Stress
Seleziona la dimensione del file di scrittura tra 1GB e 5GB, in incrementi di 1GB.  
5GB è l’impostazione di default, e produce i risultati più accurati.

Apri il menù impostazioni cliccando  
sull’icona dell’ingranaggio

Disk Speed Test Help
Lancia il pdf del manuale di Disk Speed Test. 

About Disk Speed Test
Mostra la versione del software Disk Speed Test installato.

Start
Clicca su questo pulsante per avviare il test. Disk Speed Test scrive e poi legge un file 
temporaneo sul disco selezionato. Disk Speed Test continua la scrittura e la lettura del 
file della dimensione selezionata. Per interrompere il test, clicca di nuovo Start.

Will it Work?
Questa sezione mostra la lista di formati comuni, e a lato una spunta o una X, che 
indicano se i formati sono compatibili o meno con le prestazioni del disco. Consigliamo 
di eseguire cicli di test con Disk Speed Test per svelare i formati video dalla 
prestazione incerta. Se una spunta e una X si alternano a fianco di un formato specifico, 
significa che il disco di archiviazione non è pienamente compatibile con il formato.

How Fast? (FPS)
I risultati di questa sezione mostrano i frame rate raggiungibili dal disco, e vanno letti 
insieme a quelli della sezione Will it Work?. Ad esempio, se appare una spunta verde 
per 2K DCI 25p a 10 bit YUV 4:2:2 nella sezione Will it Work, ma How Fast? (FPS) mostra 
un supporto massimo di 25 fps, la prestazione del disco di archiviazione è troppo 
marginale per essere affidabile.
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Ingranaggio 
Clicca su questa icona 
per accedere alle 
impostazioni prima  
di iniziare il test

Avvio test 
Clicca una volta su  
START per testare la 
velocità. Clicca di nuovo 
per terminare il test

How Fast? (FPS) 
Questa sezione mostra  
i risultati in fotogrammi  
per secondo (fps)

Will it Work? 
Questa sezione mostra  
i formati compatibili con 
il disco di archiviazione
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Rimuovere la scheda mezzanino 
da DeckLink 4K Extreme 12G 

Rimuovere la scheda mezzanino 
Se non c’è abbastanza spazio sulla scheda madre per una scheda PCIe con doppio slot,  
puoi rimuovere facilmente la scheda mezzanino di DeckLink 4K Extreme 12G.

Per rimuovere la scheda mezzanino:
1 Scarica l’elettricità statica dal tuo corpo. Posiziona la scheda DeckLink con i contatti 

dorati PCIe rivolti verso l’alto, e posala su una superficie piatta e pulita.

2 Alla base della scheda DeckLink trovi due viti che supportano il distanziale della 
scheda mezzanino. Sono le due viti più lontane dai connettori BNC. Rimuovile 
delicatamente con un cacciavite a croce.

3 Afferrando la base della scheda DeckLink dai lati, solleva la scheda mezzanino finché  
il connettore a ponte si estrae dallo slot.

4 Mantieni il connettore nella scheda mezzanino per ricollegarlo in un secondo tempo. 

5 Inserisci le viti nei distanziali, e conserva la scheda mezzanino in un luogo sicuro 
all’interno di un sacchetto antistatico.

Ora puoi montare la scheda DeckLink 4K Extreme 12G nel computer su un solo slot PCIe.

Per reinserire la scheda mezzanino:
1 Allinea i due distanziali con fori per viti della scheda mezzanino alla base della scheda 

DeckLink, e spingi delicatamente la scheda mezzanino nello slot del connettore a 
ponte. Assicurati che la scheda mezzanino sia inserita correttamente nel 
connettore a ponte. 

2 Fissa i distanziali alla base della scheda DeckLink serrando le viti con un cacciavite  
a croce. Non stringere troppo le viti.

Per assistenza, visita il sito Blackmagic Design alla pagina Supporto 
www.blackmagicdesign.com/it/support.

La scheda mezzanino di DeckLink 4K Extreme 12G è facilmente rimovibile
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Recuperare una scheda DeckLink  
dopo un aggiornamento non riuscito
Se l’aggiornamento di una scheda DeckLink non va a buon fine, per esempio a causa di 
un’interruzione improvvisa della corrente, è necessario eseguire un’operazione di recupero 
tramite la porta USB della scheda stessa.

Le schede DeckLink compatibili con questa operazione ospitano una porta mini USB sul retro  
o sul lato. Sfrutta questa porta per collegare la scheda direttamente al computer.

Per recuperare una scheda DeckLink dopo un aggiornamento non riuscito:
1 Spegni il computer e scollega la spina di alimentazione.

2 Estrai delicatamente la scheda DeckLink dallo slot PCIe del computer e poggiala su 
una superficie stabile. Consigliamo di usare un sacchetto antistatico e di indossare  
un braccialetto antistatico per evitare di danneggiare la scheda e di subire scosse 
elettriche.

3 Inserisci un cavo USB nella porta USB Mini B sul retro o sul lato della scheda. 

Estrai delicatamente la scheda DeckLink dallo slot PCIe del computer 
e collegala al computer tramite la porta USB Mini B

4 Inserisci l’altra estremità del cavo USB nella porta USB del computer.

705Recuperare una scheda DeckLink  dopo un aggiornamento non riuscito



5 Ricollega la spina di alimentazione e accendi il computer. Dopo la sequenza di avvio, 

una finestra chiederà di aggiornare la scheda. 

Clicca su Update.

Una barra di avanzamento segnala il termine dell’aggiornamento.

Al termine dell’aggiornamento, scollega il cavo USB e reinstalla la scheda nello slot 
PCIe del computer.

NOTA Ricorda di spegnere il computer e scollegare la spina di alimentazione prima di 
accedere allo slot PCIe.

Dopo aver reinstallato la scheda nello slot PCIe, accendi il computer. La scheda verrà rilevata e 
sarà pronta all’uso.
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Assistenza

Assistenza clienti
Il modo più veloce di ottenere assistenza è visitare la pagina Supporto sul sito 
Blackmagic Design, dove trovi il materiale di supporto più recente per il tuo hardware.

Supporto online
Per il materiale più recente, inclusi software e note di supporto, visita la pagina Supporto di 
Blackmagic Design www.blackmagicdesign.com/it/support

Contattare Blackmagic Design
Se il materiale di supporto non risponde alle tue domande, clicca su Inviaci una email, oppure 
su Trova un team di supporto per contattare direttamente il team Blackmagic Design più 
vicino a te.

Scoprire la versione del software in uso
Per scoprire quale versione del software Desktop Video Setup è installata sul tuo Mac, 
Windows, o Linux, apri Blackmagic Desktop Video Setup 

 � Su Mac OS, apri la cartella Applicazioni e seleziona Blackmagic Desktop Video Setup. 
Per controllare quale versione del software è installata, clicca alla voce del menù 
Blackmagic Desktop Video Setup. 

 � Su Windows 7, clicca il pulsante Start > Tutti i programmi > Blackmagic Design > 
Desktop Video e clicca sull’applicazione Blackmagic Desktop Video Setup.  
Per controllare quale versione del software è installata, clicca alla voce del menù 
Blackmagic Desktop Video Setup. 

 � Su Windows 8 e Windows 8.1, dalla pagina Start digita Blackmagic e poi clicca 
sull’applicazione Blackmagic Desktop Video Setup. Per controllare quale versione 
del software è installata, clicca su About Blackmagic Desktop Video Setup dalla 
barra menù. 

 � Su Windows 10, clicca su Start e digita Blackmagic nel campo di ricerca. 
Seleziona l’applicazione Blackmagic Desktop Video Setup. Per controllare quale 
versione del software è installata, clicca alla voce del menù Blackmagic Desktop 
Video Setup.

 � Su Linux, seleziona Applicazioni > Audio e video > Blackmagic Desktop Video Setup. 
Per controllare quale versione del software è installata, clicca su About Blackmagic 
Desktop Video Setup dalla barra menù. 

Stare al passo con gli aggiornamenti
Dopo aver verificato quale versione del software Blackmagic Desktop Video Setup è installata 
sul tuo computer, visita la pagina Supporto di Blackmagic Design su 
www.blackmagicdesign.com/it/support per scaricare gli aggiornamenti più recenti. Consigliamo 
di non eseguire aggiornamenti nel mezzo di un progetto importante. 

Per controllare quando è stato effettuato l’ultimo aggiornamento, clicca sulla tab 
About dell’utilità Blackmagic Desktop Video Setup. Puoi creare un rapporto di stato  
cliccando su Status Report > Create.
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Informazioni per gli sviluppatori
Sviluppare un software su misura con i dispositivi Blackmagic Design
Il pacchetto di sviluppo DeckLink SDK è disponibile agli sviluppatori per controllare i dispositivi 
video Blackmagic con il proprio software personalizzato. DeckLink SDK supporta i prodotti 
UltraStudio, DeckLink e Intensity.

DeckLink SDK combina un controllo hardware a basso livello e interfacce ad alto livello, per 
svolgere le operazioni di routine con facilità. Le seguenti tecnologie sono supportate dall’SDK:

 � DeckLink API

 � Apple QuickTime

 � Apple Core Media 

 � Microsoft DirectShow

Scaricare gratuitamente l’SDK di Blackmagic Design
DeckLink SDK è scaricabile da www.blackmagicdesign.com/it/support

Iscriversi al forum sviluppatori di Blackmagic Design
Visita il forum per sviluppatori Software Developers se cerchi risposte, suggerimenti e consigli 
sulle tecnologie impiegate da Blackmagic Design, per esempio codec, core media, API, SDK,  
e molto altro. Sul forum potrai metterti in contatto con il team di supporto Blackmagic Design e 
con altri utenti del forum, per trovare risposte alle tue domande specifiche di programmazione 
e per maggiori informazioni. Il forum degli sviluppatori Software Developers è accessibile alla 
pagina Forum http://forum.blackmagicdesign.com/

Contattare l’assistenza per sviluppatori Blackmagic Design
Contattaci all’indirizzo email developer@blackmagicdesign.com per domande al di fuori 
del forum.
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Normative
Smaltimento di apparecchiature elettriche ed elettroniche nell’Unione Europea

Questo simbolo indica che il dispositivo non deve essere scartato insieme agli altri 
rifiuti, ma consegnato a uno degli appositi centri di raccolta e riciclaggio. La raccolta e 
lo smaltimento differenziato corretto di questo tipo di apparecchiatura evita lo spreco di 
risorse e contribuisce alla sostenibilità ambientale e umana. Per tutte le informazioni sui 
centri di raccolta e riciclaggio, contatta gli uffici del tuo comune di residenza o il punto 
vendita presso cui hai acquistato il prodotto.

Questo dispositivo è stato testato e dichiarato conforme ai limiti relativi ai dispositivi 
digitali di Classe A, come indicato nella Parte 15 del regolamento FCC. Tali limiti sono 
stati stabiliti con lo scopo di fornire protezione ragionevole da interferenze dannose in 
ambienti commerciali. Questo dispositivo genera, usa e può irradiare energia a 
radiofrequenza e, se non è installato o usato in conformità alle istruzioni, può causare 
interferenze dannose che compromettono le comunicazioni radio. Operare questo 
dispositivo in ambienti residenziali può causare interferenze dannose, nella cui 
evenienza l’utente dovrà porvi rimedio a proprie spese.

Il funzionamento è soggetto alle due condizioni seguenti:

1 Questo dispositivo non deve causare interferenze dannose. 

2 Questo dispositivo deve accettare eventuali interferenze ricevute, incluse le 
interferenze che possono causare un funzionamento indesiderato.

Dichiarazione ISED (Canada)
Questo dispositivo è conforme agli standard canadesi sui dispositivi digitali 
di Classe A.

Qualsiasi modifica o utilizzo del dispositivo al di fuori di quello previsto potrebbero 
invalidare la conformità a tali standard.

Consigliamo di connettere le interfacce HDMI usando cavi schermati HDMI di 
alta qualità.

Questo dispositivo è stato testato per l’uso in ambienti commerciali. Se utilizzato  
in ambienti domestici, può causare interferenze radio.
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Sicurezza
Collegare il dispositivo a una presa di corrente con messa a terra per evitare scosse elettriche. 
Per assistenza, contattare un elettricista qualificato.

Per ridurre il rischio di scosse elettriche, evitare di esporre il dispositivo a gocce o spruzzi.

Questo dispositivo è adatto all’uso nei luoghi tropicali con una temperatura ambiente non 
superiore ai 40ºC. 

Lasciare uno spazio adeguato intorno al dispositivo per consentire sufficiente ventilazione.

Se il dispositivo è installato su rack, assicurarsi che i dispositivi adiacenti non ne ostacolino  
la ventilazione.

Le parti all’interno del dispositivo non sono riparabili dall’utente. Contattare un centro 
assistenza Blackmagic Design per le operazioni di manutenzione.

Alcuni dispositivi ospitano una porta per connettere ricetrasmettitori ottici SFP. Usare solo 
moduli SFP Laser, Class 1.

Moduli SFP consigliati da Blackmagic Design:

 � 3G-SDI PL-4F20-311C

 � 6G-SDI PL-8F10-311C

 � 12G-SDI PL-TG10-311C

Usare il dispositivo a un’altitudine non superiore a 2000 m sopra il livello del mare.

Dichiarazione dello Stato della California
Questo dispositivo può esporre l’utente a sostanze chimiche, per esempio tracce di bifenili 
polibromurati nelle parti in plastica, che nello Stato della California sono considerati causa di 
cancro e difetti alla nascita o altri difetti riproduttivi.

Per maggiori informazioni, visita la pagina www.P65Warnings.ca.gov.

Avvertenze per il personale autorizzato
Scollegare l’alimentazione da entrambe le prese prima di effettuare  
la manutenzione!

Attenzione - Fusione bipolare/neutra
L’alimentatore all’interno di questo dispositivo ha un fusibile nei conduttori  
di linea e di neutro, ed è idoneo alla connessione al sistema di distribuzione 
dell’energia elettrica in Norvegia.
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Garanzia
Garanzia limitata
Blackmagic Design garantisce al/la Cliente l'esenzione dei prodotti della linea UltraStudio, DeckLink, 
e Multibridge da difetti nei materiali e nella fabbricazione per un periodo di 3 anni dalla data 
d'acquisto. Sono esclusi i connettori, i cavi, le ventole di raffreddamento, i moduli per fibra ottica, 
i fusibili, le tastiere e le batterie, forniti privi di difetti nei materiali e nella manifattura per un periodo 
di 1 anno a partire dalla data d'acquisto. Blackmagic Design garantisce che i prodotti della linea 
Intensity sono forniti privi di difetti nei materiali e nella manifattura per un periodo di 1 anno a partire 
dalla data d'acquisto. Durante il periodo di garanzia Blackmagic Design riparerà o, a sua scelta, 
sostituirà tutti i componenti che risultino difettosi esonerando il/la Cliente da costi aggiuntivi, 
purché i componenti vengano restituiti dal/la Cliente.

Per ottenere l'assistenza coperta dalla presente garanzia, il/la Cliente deve notif icare 
Blackmagic Design del difetto entro il periodo di garanzia, e organizzare il servizio di riparazione. 
Il/la Cliente è responsabile del costo di imballaggio e di spedizione del prodotto al centro di 
assistenza indicato da Blackmagic Design, con spese di spedizione prepagate. Il costo include 
spedizione, assicurazione, tasse, dogana, e altre spese pertinenti alla resa del prodotto a 
Blackmagic Design. 

Questa garanzia perde di validità per danni causati da un utilizzo improprio, o da manutenzione 
e cura inadeguate del prodotto. Blackmagic Design non ha obbligo di assistenza e riparazione 
sotto garanzia per danni al prodotto risultanti da: a) precedenti tentativi di installazione, riparazione 
o manutenzione da personale non autorizzato, ovvero al di fuori del personale Blackmagic Design, 
b) precedenti usi impropri o tentativi di connessione ad attrezzatura incompatibile al prodotto, c) 
precedente uso di parti o ricambi non originali Blackmagic Design, o d) precedenti modifiche o 
integrazione del prodotto ad altri prodotti, con il risultato di rendere la riparazione più difficoltosa 
o di allungare le tempistiche di eventuali ispezioni atte alla riparazione. LA PRESENTE GARANZIA 
DI BLACKMAGIC DESIGN SOSTITUISCE QUALSIASI ALTRA GARANZIA, ESPLICITA O IMPLICITA. 
BLACKMAGIC DESIGN E I SUOI FORNITORI ESCLUDONO QUALSIASI ALTRA GARANZIA IMPLICITA 
DI COMMERCIABILITÀ O DI IDONEITÀ AD UN USO SPECIFICO. L'INTERA RESPONSABILITÀ DI 
BLACKMAGIC DESIGN E L'UNICO ESCLUSIVO RICORSO DELL'UTENTE PER QUALSIASI DANNO 
ARRECATO DI NATURA INDIRETTA, SPECIFICA, ACCIDENTALE O CONSEQUENZIALE, ANCHE 
QUALORA BLACKMAGIC DESIGN FOSSE STATA AVVERTITA DELLA POSSIBILITÀ DI TALI DANNI, 
È LA RIPARAZIONE O LA SOSTITUZIONE DEI PRODOTTI DIFETTOSI. BLACKMAGIC DESIGN NON 
SI ASSUME ALCUNA RESPONSABILITÀ PER QUALSIASI USO ILLEGALE DEL DISPOSITIVO DA 
PARTE DEL/LA CLIENTE. BLACKMAGIC DESIGN NON SI ASSUME ALCUNA RESPONSABILITÀ 
PER DANNI DERIVANTI DALL'USO DI QUESTO PRODOTTO. IL CLIENTE UTILIZZA QUESTO 
PRODOTTO A PROPRIO RISCHIO. 

© Copyright 2019 Blackmagic Design. Tutti i diritti riservati. ‘Blackmagic Design’, ‘DeckLink’, ‘HDLink’, ‘Workgroup Videohub’, 
‘Videohub’, ‘DeckLink’, ‘Intensity’ and ‘Leading the creative video revolution’ sono marchi registrati negli Stati Uniti e in altri Paesi. 
 Altri nomi di prodotti e aziende qui contenuti potrebbero essere marchi dei rispettivi proprietari.

Thunderbolt e il logo Thunderbolt sono marchi registrati di Intel Corporation negli Stati Uniti e/o altri Paesi.
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